Copyright and Disclaimer

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any means electronic, mechanical, photocopying, recording, or otherwise without the prior written permission of CyberLink Corporation.

To the extent allowed by law, POWERDIRECTOR IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITATION ANY WARRANTY FOR INFORMATION, SERVICES, OR PRODUCTS PROVIDED THROUGH OR IN CONNECTION WITH POWERDIRECTOR AND ANY IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, EXPECTATION OF PRIVACY, OR NON-INFRINGEMENT.

BY USING THIS SOFTWARE, YOU AGREE THAT CYBERLINK WILL NOT BE LIABLE FOR ANY DIRECT, INDIRECT, OR CONSEQUENTIAL LOSS ARISING FROM THE USE OF THIS SOFTWARE OR MATERIALS CONTAINED EITHER IN THIS PACKAGE.

The terms and conditions here under shall be governed and construed in accordance with the laws of Taiwan.

PowerDirector is a registered trademark along with other company and product names mentioned in this publication, used for identification purposes and remain the exclusive property of their respective owners.

PowerDVD Auto-Player Agreement

The PowerDVD Auto-player is provided for your personal and individual use only. Its commercial use, distribution or sublicense is strictly prohibited, regardless of whether it is for profit or not. If you would like to use the player for any of these prohibited purposes, you may be required to obtain license(s) from third party(ies) for such use, and it shall be your sole responsibility, and at your own expense, to obtain such license(s). For the same reason, you shall indemnify and hold CyberLink harmless from any claims, proceedings, damages, costs, and expenses resulting from your use of the PowerDVD Auto-player for any of these prohibited purposes. You will note that by incorporating the Auto-player, you shall be deemed to have accepted all of the terms mentioned above, and such terms shall constitute a part of the license agreement for PowerDirector between you and CyberLink.

International Headquarters

Mailing Address
CyberLink Corporation
15F, #100, Min Chuan Road, Hsin Tian City
Taipei County, Taiwan, R.O.C.

Web Site
www.gocyberlink.com

Telephone
886-2-8667-1298

Fax
886-2-8667-1300
## Contents

### Introduction .................................................. 1
  Welcome ................................................................. 2
  Where to Begin Reading .............................................. 2
  The Movie-Making Process ........................................... 3
    Pre-Production ....................................................... 3
    Editing .................................................................. 3
    PowerDirector Projects ............................................ 4
    Ready to Burn ........................................................ 4
  General Preferences .................................................. 5
  System Requirements .................................................. 7
  PowerDirector Versions .............................................. 8

### Visual Overview .............................................. 9
  The PowerDirector Program ........................................ 10
  Capture Mode .......................................................... 12
  Edit Mode ............................................................... 13
  Library .................................................................... 14
    Media Room ......................................................... 15
    Effect Room ......................................................... 15
    Title Room .......................................................... 15
    Transition Room ................................................... 15
  Audio Mixer ............................................................ 16
  Voice-over Recording Room ........................................ 17
  The Workspace ........................................................ 18
    Timeline View ........................................................ 18
    Storyboard View .................................................... 19
  Preview Window ....................................................... 20
  Media Viewer .......................................................... 21
  Media Editor ............................................................ 22
  Production Mode ...................................................... 23
  Burn Mode .............................................................. 24

### Capturing Media .............................................. 25
  Capture Preferences .................................................... 26
  Capture Options ....................................................... 28
    Capture Limit Options .............................................. 28
    Profile Options ...................................................... 29
    Analog Video Capture Options .................................. 30
    Audio Capture Options ............................................ 31
    Webcam Video Capture Options ................................. 32
CD/Microphone Capture Profile Setup .................................. 33
Captured Clip Options ...................................................... 34
Capture from DV Camcorder ................................................ 35
Capture a Single Scene ..................................................... 35
Batch Capture ................................................................. 37
Capture from TV .............................................................. 40
Capture from Webcam ....................................................... 41
Capture from Microphone .................................................. 42
Rip Audio Tracks from CD ................................................... 43
Record a Voice-over .......................................................... 44

Working with Media Clips .......................... 45
Managing Media in the Library ............................... 46
  Load Clips into the Library .............................................. 46
  Sort Clips in the Library .................................................. 47
  Remove a Clip from the Library ....................................... 48
  Rename a Clip in the Library ........................................... 49
  Restore a Clip’s Original File Name ................................. 49
  View Clip Properties ...................................................... 49
Detect Scenes in a Video Clip ........................................... 50
Managing Clips in the Workspace ................................. 52
  Add a Clip to the Workspace .......................................... 52
  Move a Clip in the Workspace ......................................... 54
  Cut/Copy/Paste a Clip in the Workspace ............................ 55
Remove a Clip from the Workspace ............................... 55
Editing Clips ................................................................. 56
  Split a Clip ................................................................. 56
  Trim a Video or Audio Clip ............................................ 57
  Take a Still Snapshot of a Video Clip ............................... 60
  Change the Speed of a Video Clip .................................... 60
  Stretch the Audio Portion of a Video Clip ......................... 61
  Mute the Audio Portion of a Video Clip ............................ 61
  Change the Color of a Visual Media Clip ........................... 62
  Set a Video Clip’s Interlacing Format ............................... 63
  Change Audio Clip Volume Levels ................................. 64
  Add a Fade Effect to an Audio Clip ................................. 65
  Mute an Entire Audio Clip ............................................. 66
  Restore an Audio Clip’s Volume Levels .............................. 66
  Preview a Clip ............................................................. 67

Working with Effects ............................ 69
Managing Effects in the Library ............................... 70
Sort Effects in the Library ................................................ 70
Restrict the Display of Effects ........................................... 70
Add an Effect to My Favorites .......................................... 71
Remove an Effect from My Favorites ............................... 71
Managing Effects in the Timeline ................................. 72
# Table of Contents

Add a Video/Title/Transition Effect .............................................. 72  
Replace an Effect in the Timeline .................................................. 73  
Delete an Effect ........................................................................... 73  
Move an Effect in the Workspace .................................................. 74  
Cut/Copy/Paste an Effect in the Workspace .................................... 74  
Modifying Effects ......................................................................... 75  
Set an Effect’s Hold Time ............................................................. 75  
Split a Video, Title, or PiP Effect ..................................................... 76  
Set an Effect’s Duration ................................................................. 76  
Modifying a Video Effect ............................................................... 78  
Modifying a PiP Effect .................................................................... 79  
Modify a Title Effect ...................................................................... 87  
Preview an Effect ......................................................................... 91  

## Producing Your Movie ............................................................... 93  
Preview Your Movie ...................................................................... 94  
Preview Your Movie in the Preview Window .................................. 94  
Preview Your Movie in the Media Viewer ..................................... 95  
The Production Wizard .................................................................. 96  
Produce a Disc ............................................................................. 97  
Create a File .................................................................................. 101  
Create an AVI File ......................................................................... 101  
Create a DivX File .......................................................................... 108  
Create an MPEG1/MPEG2 File ....................................................... 110  
Create a Streaming File ............................................................... 112  
Create a WMV File for Streaming ................................................ 112  
Create a RealVideo File for Streaming .......................................... 114  
Create a QuickTime File for Streaming ....................................... 117  
Write Back to DV Tape ................................................................ 120  

## Appendix .................................................................................... 123  
Technical Support ......................................................................... 124  
Web Support ................................................................................. 124  
Fax Support ................................................................................... 124  
Telephone Support ....................................................................... 125  
Hotkeys .......................................................................................... 126  
FAQ ................................................................................................. 133  
The Right Technology ................................................................... 139  
CD vs. DVD .................................................................................. 139  
NTSC vs. PAL ................................................................................ 142  
Video Quality ................................................................................ 142  
Glossary ........................................................................................ 144  

## Index .......................................................................................... 151
Chapter 1:

Introduction

This chapter introduces CyberLink PowerDirector and the digital video editing process. It provides a discussion of the different kinds of technology you will use in the digital movie-making process, as well as system requirements for working smoothly with CyberLink PowerDirector.

This chapter contains the following sections:

- Welcome on p.2
- The Movie-Making Process on p.3
- General Preferences on p.5
- System Requirements on p.7
- PowerDirector Versions on p.8
Welcome

Welcome to the CyberLink family of digital video tools! PowerDirector is a digital video editing program that can help you create professional-looking video movies, complete with music, voice-over, special effects, and transition effects.

If you don’t have experience making movies, don’t worry. CyberLink PowerDirector provides home users with a simple tool to help them do something a little more creative with their home videos. You don’t have to be a video professional or have aspirations of a box office hit to enjoy using PowerDirector.

Where to Begin Reading

Of course, we hope that you will read through the entire User’s Guide for complete information on working with CyberLink PowerDirector. However, some people like to just jump in and get working on specific projects. If you are one of those people, please refer to the list below for the page numbers of the information you are looking for.

- If you have questions about the program or the digital movie-making process, start by reading the Introduction on p.1, then the Visual Overview on p.9.
- If you want to capture media, read Capturing Media on p.25.
- If you want to put your media clips together into a story, start by reading Editing Clips on p.56.
- If you want to modify your media clips, read Working with Media Clips on p.45.
- If you want to modify your story, read Working with Effects on p.69.
- If you want to create a disc, start by reading Producing Your Movie on p.93, then Burning Your Movie to Disc on p.123.
The Movie-Making Process

The digital movie production process involves a combination of artistry and technology, beginning with raw video footage and ending with a movie production. CyberLink PowerDirector provides the easiest way to produce your finished movie and publish it to the medium of your choice.

Pre-Production

Before you edit your movie using CyberLink PowerDirector, you must first create (or gather) its component parts: video clips, photos, music, and narrative voice-overs.

You may collect raw footage yourself with a camcorder or other recording device, or you may simply use non-copyright protected media files that you have on hand.

You should have all of the bits and pieces of your movie on hand so that the video editing process goes as smoothly as possible.

Editing

When you have your raw footage on hand, you might expect to use CyberLink PowerDirector to perform the following tasks:

1. Acquire video and audio content.
2. Trim video and audio content to a desired length.
3. Add a special effect to a video clip.
4. Adjust the sharpness, contrast, and color of a video clip.
5. Mix your background and voice-over tracks.
6. Add transition effects between video clips.
7. Preview your production.
8. Burn your production to CD/DVD.
PowerDirector Projects

Whatever changes you make to your video clips, audio files, or photos in CyberLink PowerDirector does not affect your original media. Since your settings are all saved in the project file, you can trim, edit, or delete clips in PowerDirector, but still keep your original files on your hard drive, untouched. So let yourself get creative! If you end up changing things too drastically, you can always start over.

You can open and save a PowerDirector project file just like any other file in Windows. You can also create a new file or save the current file under a different file name.

Ready to Burn

When you are ready to burn your movie to disc, you should have several discs on hand that are compatible with your burning drive. Make sure not only that the media type is correct (i.e.: that you have DVDs for a DVD drive and CDs for a CD drive), but that your discs are all in the correct format (for example, CD-R or DVD+RW).

Keep several discs on hand in case your drive encounters errors, or to make duplicate copies when you are satisfied with the results.
General Preferences

CyberLink PowerDirector offers a range of choices to set your video production environment to better suit the way you work.

To set your working preferences, do this:

1. **Click Edit > Preferences...** The Preferences dialog box opens.

2. Set your preferences:
   - **Import directory:** Set the folder where PowerDirector looks by default for media clips when you load media files. To change this folder, click **Browse** and select a new folder.
   - **Export directory:** Set the folder where PowerDirector saves captured media files by default. To change this folder, click **Browse** and select a new folder.
   - **Durations:** Set default durations (in seconds) for image files, titles, transitions, and video effects.
   - **Undo levels:** Enter a number (between 0 and 100) of levels of undo you would like to make available while you work on your movie production. Setting a higher number of undo consumes more CPU resources.
- Recently used file list: Enter a number (between 0 and 20) of recently used files that you would like to make available in the File menu when you open PowerDirector.

- TV format: Select the TV format (NTSC or PAL) of the region in which you would like to produce your movie. This format should correspond to the format of the region in which you plan to play your movie (if you burn it to disc).

- Always prompt me when TV format conflicts: Check this option to enable a warning message when you add a video clip to the workspace whose TV format (NTSC/PAL) conflicts with that of the video clips already located in the workspace.

- Default mode: Select to open PowerDirector in Timeline or Storyboard mode by default.

- Production preview: Select On to enable the video preview window during production. Select Off to disable the preview window during production and reduce production time.

- Automatically load the most recent project: Check this option to load the project you have been working on most recently whenever you open PowerDirector.

- Enable file deletion from hard drive and ask me for confirmation: Check this option if you would like to be able to delete files located on your hard drive using a menu option in the Library.

3. Click OK.
System Requirements

The system requirements listed below are recommended as minimums for general digital video production work. You may find that your system, while meeting these recommended minimums, requires expanded capacity during specific DV editing tasks.

<table>
<thead>
<tr>
<th></th>
<th>Minimum</th>
<th>Recommended</th>
</tr>
</thead>
<tbody>
<tr>
<td>Screen Resolution</td>
<td>1024 x 768, 16-bit color</td>
<td>1024 x 768, 32-bit color</td>
</tr>
<tr>
<td>Memory</td>
<td>128MB</td>
<td>256MB DDR</td>
</tr>
<tr>
<td>CPU</td>
<td>Capture/Produce AVI: P2-450</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Capture/Produce MPEG-1: P3-600</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Capture/Produce MPEG2: P4-2G</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Optimized for CPU with SSE, SSE2, 3DNow!, and HyperThreading technology</td>
<td></td>
</tr>
<tr>
<td>HDD Space</td>
<td>1GB for making VCD/SVCD/MiniDVD</td>
<td>3GB for making VCD/SVCD/MiniDVD</td>
</tr>
<tr>
<td></td>
<td>10GB for making DVD</td>
<td>15GB for making DVD</td>
</tr>
<tr>
<td></td>
<td>7200RPM drive</td>
<td></td>
</tr>
<tr>
<td>Video Capture</td>
<td>PCI or USB1.0/2.0 capture device compliant with WDM standard (For example, PC Camera and TV tuner with WDM driver)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>DV/D8 camcorders connected via OHCI-compliant IEEE1394</td>
<td></td>
</tr>
<tr>
<td>CD/DVD Burning</td>
<td>CD or DVD burner (CD-R/RW, DVD+-R/+RW) is required to burn VCD/DVD/SVCD/MiniDVD titles</td>
<td></td>
</tr>
<tr>
<td>Mic</td>
<td>A microphone is required to record a voice-over</td>
<td></td>
</tr>
</tbody>
</table>
PowerDirector Versions

PowerDirector is available in many different OEM versions and the full retail version. File format support, editing features, disc-making functions, and other features vary depending on the version that you have. For information on the availability of specific functions in the PowerDirector version that you are using, please check the PowerDirector Readme file.
Chapter 2: Visual Overview

This chapter introduces the CyberLink PowerDirector program and the components that are available in PowerDirector’s different modes. Descriptions in this chapter focus on the appearance of the program, not on procedures for using the program. For instructions on how to use the program, refer to the many function-specific sections throughout the rest of the manual.

This chapter contains the following sections:

- The PowerDirector Program on p.10
- Capture Mode on p.12
- Edit Mode on p.13
- Library on p.14
- Media Room on p.15
- Effect Room on p.15
- Title Room on p.15
- Transition Room on p.15
- Audio Mixer on p.16
- Voice-over Recording Room on p.17
- The Workspace on p.18
- Preview Window on p.20
- Media Viewer on p.21
- Media Editor on p.22
- Production Mode on p.23
- Burn Mode on p.24
The PowerDirector Program

When you first open PowerDirector, the program appears as follows:

- **Library**: Contains media clips, effects, and transitions
- **Mode buttons**: Click to switch working modes
- **Preview window**: Provides playback controls to preview clips and movies
- **Smart Guide**: Provides function-specific tips
- **Media tracks**: Insert media clips here
PowerDirector has four modes that enable you to perform different tasks: Capture, Edit, Produce, and Burn.

- **Capture**
  - Click to switch to the capture interface. See Capture Mode on p.12.

- **Edit**
  - Click to switch to the editing interface. See Edit Mode on p.13.

- **Produce**
  - Click to switch to the production interface, which opens the Disc Wizard. See Production Mode on p.23.

- **Burn**
  - Click to switch to the burning interface, which opens the PowerProducer tool. See Burn Mode on p.24.

The PowerDirector program changes appearance depending on mode. (By default, the program opens in Edit mode.) In addition, certain parts of the program may change within a specific mode. For example, the Library changes display when you click an editing function button, and the workspace can toggle between Timeline and Storyboard views. The different modes and the varying appearances they bring to the PowerDirector program are all described in the sections that follow.
Capture Mode

When you click the \[Capture\] button, PowerDirector enters Capture mode, in which you can capture media from a variety of capture devices. In Capture mode, the program appears as follows:

- **Capture preview window**
  Displays media clips during capture.

- **Captured Clips area**
  Displays media clips after capture.

- **Capture device selection area**
  Allows you to switch capture devices and set capture limits.

- **Information display area**
  Displays information about captured file size and available HDD space.

For more information on capturing media, see Capturing Media on p.25.
Edit Mode

When you click the Edit button, PowerDirector enters Edit mode, in which you can edit your video production. In Edit mode, the program appears as follows:

**Edit function buttons**
Open editing rooms dedicated to a specific task

**Workspace view buttons**
Click to switch between Timeline and Storyboard views

For more information on editing a video production, see Working with Media Clips on p.45 and Working with Effects on p.69.
Library

The Library is the storeroom in which all of the media clips used in your projects are kept. In addition, the Library displays all of the different types of effects that can be applied to media clips. The Library appears as follows:

Which contents the Library displays depends on the edit function button you click. These buttons are shown below:

Each of these buttons opens an editing ‘room’ dedicated to a specific task. By default, the Library opens to the Media Room. However, the Library retains the same buttons and functions in each of these views.
Chapter 2: Visual Overview

**Media Room**

The Media Room is the storage area for the media that you will use in your video editing project. Which type of media clips appear in the Media Room depends on the selection you make in the Filter drop-down list.

**Effect Room**

The Effect Room contains all of the special effects that can be applied to video or image clips in the workspace.

**Title Room**

The Title Room contains all of the title effects that can be applied to the workspace.

**Transition Room**

The Transition Room contains all of the transition effects that can be applied between video or image clips in the workspace.
The Audio Mixer contains audio mixing controls for the different audio tracks in the workspace. The Audio Mixer appears as follows:
Voice-over Recording Room

The Voice-over Recording Room contains controls for recording a narration from a microphone while watching the video clip the voice-over is destined to accompany. The Voice-over Recording Room appears as follows:
The Workspace

The edit interface consists of a workspace to which you can add clips. You can set which view opens by default in the Preferences dialog box. You can also switch views by clicking the Timeline or Storyboard buttons.

Timeline View

When you first open PowerDirector, the program opens to the Edit interface in whichever mode you have set in your preferences.

To switch to Timeline view, click \[
\]
. The workspace appears as follows:

The Media Tracks

**Video** Contains your movie’s main video and/or image clips.

**Effect** Contains special effects that apply to the video or image clip in the Video track at the same location.

**PiP** Contains video/image clips, which are overlaid on any clip in the Video track that appears during the PiP effect’s duration.

**Title** Contains title effects that appear over any clips in the Video track that occur during the title effect’s duration.

**Voice** Contains a narrative voice-over or second audio clip.

**Music** Contains your movie’s main audio clip.
Resizing the Ruler

You can resize the ruler for a more expanded or more condensed view of your production. The graphics below show the effect of a condensed versus an expanded ruler:

Condensed ruler:

![Condensed Ruler Graphics]

Expanded ruler:

![Expanded Ruler Graphics]

To resize the ruler, click inside the ruler and drag. Expand the ruler for more a precise view, which is especially handy when aligning clips and effects, or condense the ruler for a global overview of your entire production.

Storyboard View

You can switch to Storyboard view while editing your movie for a simpler view of the clips that your movie contains.

To switch to storyboard view, click ![Storyboard View Icon]. The workspace appears as follows:

![Storyboard View Graphics]
The preview window to the right of the Library allows you to preview both media clips located in the Library as well as your entire movie production.
Media Viewer

The Media Viewer allows you to preview media clips as well as your entire movie production in a large, resizable window. The Media Viewer appears as follows:

**Preview window**
Provides playback controls to preview your movie

**Playback controls**
Allow you to control playback of clips
Media Editor

The Media Editor is similar to the Media Viewer but offers additional functions for trimming video clips. The Media Editor appears as follows:

**Preview window**
Provides playback controls to preview your movie.

**Playback controls**
Allow you to control playback and editing of clips.

**Precise Cut sliders**
Allow you to trim long videos accurately.
Production Mode

When you click the **Produce** button, PowerDirector enters Production mode, in which you can compile your movie into a file that is ready for a variety of destinations, including burning to disc. In Production mode, PowerDirector opens the Production Wizard. The Production Wizard appears as follows:

- **Preview window**
  Provides playback controls to preview your movie

- **Information display area**

- **Production mode buttons**

For more information on producing your movie, see Producing Your Movie on p.93.
Burn Mode

When you click the button, PowerDirector enters Burn mode, in which you can burn your produced movie to disc. In Burn mode, PowerDirector opens the PowerProducer. For more information on burning your movie to disc, see PowerProducer help.
Chapter 3:

Capturing Media

This chapter explains how to acquire media for use in CyberLink PowerDirector. You can acquire video and audio from a wide variety of sources, including a webcam, camcorder, TV, VCR, microphone, and audio CD.

This chapter contains the following sections:

- Capture Preferences on p.26
- Capture Options on p.28
- Capture from DV Camcorder on p.35
- Capture from TV on p.40
- Capture from Webcam on p.41
- Capture from Microphone on p.42
- Rip Audio Tracks from CD on p.43
- Record a Voice-over on p.44
Capture Preferences

Before you begin to capture, make sure your capture environment is set according to your preferred working methods.

1. To set your capture preferences, click Edit > Preferences. The Preferences dialog box opens.

2. Click the Capture/Export tab and set your preferences, if necessary:
   - **Add captured files to Library**: Check this option to import captured files into the Library, and switch to Edit mode.
   - **Add captured files to workspace**: Check this option to import captured files into the workspace, and switch to Edit mode.
   - **Use video overlay for capture**: Keep this option checked during capture unless you have an older VGA card that does not support video overlay. (Unchecking this option in this event avoids the unsupported overlay display error.)
   - **Enable automatic file replacement during voice-over**: Check this option to overwrite existing audio if the voice-over overlaps during recording.
• **Captured video filename**: Enter a default name for captured video files. PowerDirector automatically appends a sequential number to this name to create a unique filename for each captured file.

• **Always prompt me to confirm filename**: Check this option if you would like PowerDirector to prompt you to enter a filename each time you capture video (or take a snapshot).

• **Snapshot filename**: Enter a default name for snapshot captures. PowerDirector automatically appends a sequential number to this name to create a unique filename for each captured file. Select a file format from the drop-down list.

• **Snapshot destination**: Select a destination for snapshot captures from the drop-down list.

• **Do not detect scenes during capture**: Check this option if you do not want to activate the scene detection function during capture.

• **After capture, detect scenes by changing of video frames**: Check this option to perform scene detection during video capture. In scene detection, PowerDirector compares captured frames to decide when there is a scene change. Each scene is saved as a file as recording continues.

• **During capture, detect scenes by timecode, and save each scene as a separate file (DV-VCR mode only)**: Check this option to detect scene-break signals and to save each scene as a separate file. (DV camcorder generate a scene-break signal on the tape whenever users release the REC button.) This feature is only available in DV tape capture.

• **DV Parameters button**: Click this button to set the buffer parameters for your DV camcorder. Setting a buffer time ensures that your DV camcorder and your batch capture or DV writing device begin at the same time. Without a buffer, batch capturing or writing to tape may begin before the camcorder is engaged.

3. Click **OK**.
Capture Options

Many of the options for capturing are shared by different capture modes. These options are described below. Not all of the options described in this section are available in all capture modes. Descriptions of options specific to a single capture mode are found in the section that describes that mode.

**Note:** PowerDirector’s capture functions vary, depending on version. For information on the availability of specific features in the PowerDirector version that you are using, please check the Readme file.

Capture Limit Options

You can set limits on the size or duration of video that PowerDirector captures. When the limit you set is reached, capture automatically stops.

To set a maximum capture length, check **Time limit**, then enter a time in the timecode box.

To set a maximum captured file size, check **Size limit**, then enter a size limit (in MB).
Profile Options

Click **Profile**. The Profile Setup dialog box opens.

- For more information on MPEG profiles, see Create a New MPEG-1/MPEG-2 Profile on p.99. For more information on AVI options, see Windows AVI on p.104.
- Click the **Comments** and **Details** buttons for more information about the profile.
Analog Video Capture Options

Click Video. The Analog Video Settings dialog box opens, displaying the Video Setup tab. You may select your capture source here.

Click the Video Adjustment tab and set the video options, if necessary.

Click the TV Setup tab and set the TV options, if necessary.
Audio Capture Options

Before you capture from microphone, there are several options you can set.

Drag the volume level slider to set the input volume level.

Check **Begin with fade-in** to start an audio capture in with a fade-in from silence.

Check **End with fade-out** to end an audio capture with a fade-out to silence.

Click **Audio**. The Audio Setup dialog box opens. You may select your audio input device, audio input source, and input volume here.
Webcam Video Capture Options

When capturing from a webcam, click Video to set up your webcam capture profile. Under the Video Setup tab, you can select your capture source. Click Advanced Settings for more options.

Click the Video Adjustment tab and drag the sliders to increase or decrease the intensity of the video attributes here.

- Click Revert to clear the changes you have just made.
- Click Default to reset the attributes to their original levels.
CD/Microphone Capture Profile Setup

When recording from CD or microphone, click Profile to set up your CD or microphone recording profile. You may select an audio quality here.

- You can save a profile using a unique name by clicking the Save As... button. Click Remove to remove the new profiles you create.
Captured Clip Options

After you capture clips, a number of options are available for managing them. Some of these options appear in the dialog box immediately after capture, while others are available in the Captured Clips area of the Capture window.

Click **Change Folder** to set a different destination folder for captured clips.

**Note:** Set this option **before** capturing clips.

Post-Capture Options

To delete a captured file, click **Delete** in the dialog box that appears after recording.

To name a captured file, enter a name in the dialog box that appears after recording. To use default names for captured files, check the **Don’t ask me to rename files again** option in the dialog box that appears after recording.

Captured Clips Area Options

Captured clips appear in the Captured Clips area. Right-clicking clips in this area displays a menu that provides several options:

- **Delete from Disk**: Select this option to remove the clip from the Detected Scenes area and delete the source file from your hard disk.
- **Remove Item**: Select this option to remove the clip from the Detected Scenes area.
- **Play in Media Viewer**: Select this option to view the clip in the Media Viewer. See Preview a Clip in the Media Viewer on p.68.
- **Detect Scenes**: Select this option to detect the scenes contained in a video clip. See Detect Scenes in a Video Clip on p.50.
Capture from DV Camcorder

DV camcorders are popular among video hobbyists, as they record in a digital format that does not require conversion before being used on a computer, and often provide a number of advanced recording options. You can capture a single scene or a number of scenes in a batch from your camcorder. Procedures for both methods are described below.

Capture a Single Scene

You can capture a single segment of video from your camcorder. This function is particularly useful, for example, if you want to acquire a long video segment in its entirety without skipping over sections.

To capture a single scene from a DV camcorder, do this:

**Note:** Make sure your camcorder is in VRC mode before capturing.

1. Click to open Capture mode.

2. Click to open the DV camcorder capture function. (You may have to wait a few moments as PowerDirector switches devices.)
3. Locate the position at which you would like to begin capturing. You may do this in one of the following ways:
   - Use the playback buttons.
   - Drag the time slider.
   - Enter a timecode, then click to seek to that timecode.
4. Set your capture options (if necessary). See Capture Options on p.28.
   - Check Non-realtime to continue processing captured video after the original video stops playing in order to ensure that no frames are dropped. Capturing video at a higher speed reduces processing time, but yields video of a lower quality. Capturing better quality video requires more CPU power and more time to complete.
5. Click to begin capture. The video plays in the preview window as you capture.
   - Click to stop capture before completion.
6. Enter a name in the dialog box that appears. The clips you have captured appear in the Captured Clips area.
Chapter 3: Capturing Media

Batch Capture

Batch capturing may seem intimidating, but in reality, it is an incredibly convenient method of capturing multiple video clips automatically. If you take a few minutes to familiarize yourself with batch capturing, you will save yourself loads more time when you capture video from your camcorder. PowerDirector scans your DV for intervals, then allows you to batch capture from the clips created using intervals.

To batch capture from a DV camcorder, do this:

**Note:** Make sure your camcorder is in VRC mode before capturing.

1. Click ![Capture](Capture.png) to open Capture mode.
2. Click ![DV capture](DVcapture.png) to open the DV device capture function. (You may have to wait a few moments as PowerDirector switches devices.)
3. Set your capture options (if necessary). See Capture Options on p.28.
   - Check **Non-realtime** to continue processing captured video after the original video stops playing in order to ensure that no frames are dropped.
4. Click 🔄. The DV Quick Scan dialog box opens.

5. Locate the position at which you would like to begin scanning for intervals. You may do this in one of the following ways:
   - Use the playback buttons.
   - Drag the time slider.
   - Enter a timecode, then click ⏯️ to seek to that timecode.

6. Click Start Scan to start scanning for intervals.

7. Click Stop Scan after all of the video segments you want to capture have been scanned. Scanned intervals appear as thumbnails in the window.
8. Check the thumbnails of the intervals you want to batch capture.
   - You can change the profile of the clips to be captured. To do this, click **Profile** and select a new profile.
   - To combine sequential intervals into a single interval, check the intervals, then click **Merge**. Click **Auto-Merge** to combine intervals to combine all checked intervals in sequence or to merge all of the clips in an interval that you can set.

9. Click **Start Capture** to begin batch capture. PowerDirector rewinds your tape to the position of first clip, then begins capturing all of the intervals you have checked. The video plays in the preview window as you capture. The clips you have captured appear in the Captured Clips area.
   - Click **Stop Capture** to stop the capture process.

10. Click **Finished** to return to Capture mode.
You may wish to add segments from your favorite TV programs to your movie production, or simply record other segments for different uses.

To capture from TV, do this:

1. Click [Capture] to open Capture mode.
2. Click [TV] to open the TV capture function. (You may have to wait a few moments as PowerDirector switches devices.)
3. Set your capture options (if necessary). See Capture Options on p.28.
   - Click [CATV] if you have CATV, or click [Antenna] if your TV has an antenna.
4. Locate the channel you want to capture. You may do this in one of the following ways:
   - Click [Up] to go up a channel or [Down] to go down a channel.
   - Click [Return] to return to the previous channel.
   - Enter a channel number in the channel box.
5. Click [Capture] to begin capture.
6. Click [Stop] to stop capture.
7. Enter a name in the dialog box that appears. The clips you have captured appear in the Captured Clips area.
Capture from Webcam

Webcams (also known as PC cameras) are inexpensive, handy video cameras that you can use for simple video capturing.

To capture from webcam, do this:

1. Click ✅ to open Capture mode.

2. Click 📹 to open the webcam capture function. (You may have to wait a few moments as PowerDirector switches devices.)

3. Set your capture options (if necessary). See Capture Options on p.28.

4. Click 🔴 to begin capture.

5. Click ❌ to stop capture.

6. The clips you capture appear in the Captured Clips area.
Capture from Microphone

Your movie may require a narrative voice-over, or you may elect to record dialog in a studio for better acoustics. No matter what kind of audio tracks you record, they can be captured with a microphone for use in your PowerDirector project.

To capture from microphone, do this:

1. Click to open Capture mode.

2. Click to open the microphone capture function. (You may have to wait a few moments as PowerDirector switches devices.)

3. Set your capture options (if necessary). See Capture Options on p.28.
   - Click to add a fade-in effect.
   - Click to add a fade-out effect.

4. Set your master audio level. To do this, click , then drag the slider to the desired recording level. (You may also adjust audio levels on the fly while recording.)

5. Click to begin capture. Recording begins after a three-second countdown.

6. Click to stop capture.
Rip Audio Tracks from CD

Using your favorite music can help you to create a really fun, personalized movie. If you have music stored on an audio CD, you can rip the songs you want and then add them as audio tracks in PowerDirector.

To rip audio tracks from CD, do this:

1. Click \[\text{Capture}\] to open Capture mode.
2. Click \[\text{CD capture}\] to open the CD capture function. (You may have to wait a few moments as PowerDirector switches devices.)
3. Select a drive.
4. Select the track you want to rip.
5. Set your capture options (if necessary). See Capture Options on p.28.
6. Click \[\text{capture button}\] to begin capture.
   - Click \[\text{stop capture button}\] to stop capture.
7. Enter a file name for the captured file and click OK.
Record a Voice-over

The Voice-over Recording Room is located in the Library in Edit mode. Using the Voice-over Room, you can record a voice-over narration while watching the accompanying video. When you capture your narration, the audio track is synched with the video portion.

To record a voice-over, do this:

1. Click to open the Voice-over Recording Room.
2. Set your voice-over options. See Capture Options on p.28.
   - Click to add a fade-in effect.
   - Click to add a fade-out effect.
3. Locate the point in your movie at which you want to begin recording a voice-over. You may do this in one of the following ways:
   - Drag the Timeline slider.
   - Drag the preview window slider.
   - Use the playback buttons.
   - Enter a timecode in the timecode box.
4. Drag the Recording volume level slider to set the input volume level.
5. Click to begin recording. Record your voice-over as you watch the video in the preview window.
6. Click to stop recording.
7. Click to close the Voice-over Recording Room.
Chapter 4:

Working with Media Clips

This chapter discusses how to load media into the Library for use in your projects, how to add your media clips to the workspace, then how to manipulate and edit media clips once they are loaded into the workspace. Adding and manipulating media clips allows you to construct the framework of your movie production - to lay out and organize the story you want to tell.

This chapter contains the following sections:

- Managing Media in the Library on p.46
- Managing Clips in the Workspace on p.52
- Editing Clips on p.56
Managing Media in the Library

After you have obtained the media files you want to work with, the next step is to add them into the Library (where they become media “clips”) in order to make them available for your movie. Once your clips are loaded, you can change the display of your media clips in the Library and delete unnecessary clips.

Load Clips into the Library

When loading media clips into PowerDirector’s Library, you have two options: to load media files individually, or to load an entire folder that contains media files you want to use in your current project.

Note: PowerDirector’s file format support varies, depending on version. For information on the availability of specific features in the PowerDirector version that you are using, please check the Readme file.

Load Individual Media Files

To specify individual media files to load into the Library, do this:

1. Click \(\text{\Large \text{+}}\) to open the Media Room in the Library.

2. Select the type of media you want to load (or All Media) from the Filter drop-down list.

   Note: By selecting a media type (other than All Media) in this drop-down list, you restrict the type of media displayed in the Library, and consequently, the type of media that you can import.

3. Click \(\text{\Large \text{\rightarrow}}\) and select Load media file(s). A dialog box opens.

4. Locate and open the file(s) you want to add. Thumbnails of each of the media files you have selected appear in the Library.
Load a Media Folder

To load all of the media files in a particular folder, do this:

1. Click to open the Media Room in the Library.
2. Click and select Load a media folder. A dialog box opens.
3. Locate the folder you want to open, then click OK. All of the media files in that folder are loaded into the Library.

Sort Clips in the Library

Once your media clips are loaded into the Library, you can restrict the display to a certain type of media for a simpler view, and you can also sort media files using different criteria.

- Select the type of media you want to view (or All Media) from the Filter drop-down list. Only those clips that belong to the media type you have selected are displayed in the Media Room.
- To change the way media files are sorted, click . Select Sort by, then choose a sorting option (Name, Duration, File size, Date, Type).

Note: Color boards can be sorted by Name, R (Red), G (Green), and B (Blue), or Date.

- To change the way media files are displayed, click . Select Display by, then choose a display option (Thumbnails or Details).
Remove a Clip from the Library

To remove a media clip from the Library, do this:

1. Click to open the Media Room in the Library.
2. Select the clip(s) you want to remove, then do one of the following:
   - Press the Delete key.
   - Click and select Delete selected.

   - Right-click the clip(s), then select Remove from Library or Delete from disk.

   ![Media Room menu]

**Note:** The Remove from Library option makes the clip unavailable in the Library but does not affect the original media file on your hard disk. The Delete from disk option both removes the clip from the Library and deletes the original file on your hard disk.
Chapter 4: Working with Media Clips

Rename a Clip in the Library

Clips you import into the Library retain their original file names, which are often non descriptive and difficult to use in a video editing project. By using an alias, you can rename any clip in the Library to better suit your project. (For example, you may wish to use the alias “first video clip” instead of “video_005.mpg.”)

To rename a clip using an alias, do this:

1. Right-click the clip you want to rename and select **Use alias**.
2. Enter a name and press Enter on your keyboard or click outside the name box. The clip appears in the Library using the alias.

Restore a Clip’s Original File Name

Although using an alias is handy while working on your video project, you may find it necessary to view the original name of the clip (for example to verify which version of a clip you are using).

To restore a clip’s original name, right-click the clip you want to rename and select **Restore original clip name**. The clip now appears in the Library using the original clip name.

View Clip Properties

If you need to view information about a media clip in the Library or the workspace (such as its format, file path, size, frame rate, etc.), you can view the clip’s properties.

To view clip properties, right-click the clip and select **Properties**. The Properties dialog box opens.
Detect Scenes in a Video Clip

The scene detection function automatically creates individual clips based on the individual scenes contained within a video clip. Detected scenes are not split from the original clip, but can be added to the workspace like any other media clip. Likewise, they may also be merged together or removed entirely without changing the original video clip.

1. To detect scenes in a video clip in the Library, do this:
2. Select the video clip whose scenes you want to detect.
3. Click . The Scene Detection window opens.
4. Increase or decrease scene detection sensitivity, if necessary. Increased or decreased scene detection sensitivity yields an increased or decreased number of scenes that are detected. You may do this in one of the following ways:
   - Drag the Sensitivity slider.
   - Click the or buttons.
5. Click Settings and set your scene detection options, if necessary:
   - The Detection Method section pertains to video clips that have been captured. (If the video clip was not captured, the Detection Method options are disabled.) If you have a DV AVI clip that contains multiple timecodes (i.e.: timecodes are automatically set when you start and stop recording) and you wish to split up your clip in this manner, select Detect by changing of timecodes. Otherwise, use Detect by changing of video frames.
Chapter 4: Working with Media Clips

- To detect more precisely within a video clip that contains fades, check the **Ignore fade-ins/outs** option.
- To detect more precisely within a video clip that contains bright flashes (for example, camera flash), check the **Ignore flashing lights** option.

6. Locate the position at which you would like to begin detecting scenes. You may do this in one of the following ways:
   - Use the playback buttons.
   - Drag the time slider.
   - Enter a timecode.

**Note:** You may, of course, detect scenes from the start of the clip.

7. Click **Detect**. The video clip plays in the Preview Window from the point you have set.

**Note:** To set scenes manually, click **Split** instead of **Detect**.

   - To stop the scene detection process before completion, click **Stop** or press the `<Esc>` key.
   - After the original scene detection, you may further detect scenes within a newly generated scene. To detect scenes manually (including changing detection sensitivity), select a scene, then repeat the steps for detecting scenes. To detect scenes automatically, right-click a scene and select **Detect again from this scene**.
   - To remove a scene after detection, select the scene and click **Remove**, or right-click the scene and select **Remove scene**.

8. Click **OK** to close the Scene Detection window.

   - To return to the Library, click **Up One Level**.

Clips created by the new scenes are displayed in a subfolder under the original video clip. They can be added to the workspace and managed in the Library like any other video clip.

Video clips that contain detected scenes show a small folder icon in the lower right-hand corner of the clip when displayed in the Library. To display a clip’s scenes, click the folder icon.
Managing Clips in the Workspace

Once you have loaded media files into the Library, they are ready to be used in your movie. You can load different types of media clips into the different tracks in the workspace, move them to different locations in your story, and delete them from the workspace.

Add a Clip to the Workspace

The different types of media clips may only be added to specific tracks. The sections below describe the procedures for adding each kind of media clip into the workspace.

Note: You may prefer to add clips in Storyboard view, since this view is simpler than the Timeline view. However, clips can only be added to the Video track in this view. Therefore, this section uses the Timeline view in all of the procedures.

Add Video & Image Clips

You can add video and image clips to either the Video track or the PiP (picture-in-picture) track. To create the basic framework of your movie, add video and image clips to the Video track. Add clips to the PiP track only to create a picture-in-picture effect.

Note: For more information on using PiP effects, see Replace an Effect in the Timeline on p.73 and Modifying a PiP Effect on p.79.

To add video or image clips to the workspace, do this:

1. Click to open the Media Room in the Library.
2. Select Video, Image, or All Media from the Filter dropdown list to sort the clips in the Media Room.
3. Select a clip, then add it to the workspace. You may do this in one of the following ways:

- Click \[\text{Video track}\] to add the clip to the Video track or \[\text{PiP track}\] to add the clip to the PiP track.
- Drag clips to a desired position in the Video or PiP track. When adding clips to the Video track, you cannot leave an empty gap between the last clip and the new clips you are adding. Clips added to the end of the Video track follow immediately after the final clip in that track.

**Note:** You may select several clips and drag them together into the same track, provided all of the clips are compatible with the destination track.

**Add Color Boards**

Using color boards allows you to insert solid frames of color into your movie. You might, for example, want to fade in to or out from a certain color, or add a solid background to a picture-in-picture effect.

Color boards are not media files as such, but they can be applied to the workspace and managed in the Library just like video and image clips. You can add color boards to either the Video or the PiP track.

To add a color board to the workspace, do this:

1. Click \[\text{Media Room}\] to open the Media Room in the Library.
2. Select **Color boards** from the Filter drop-down list. The current color boards appear in the Library.
3. Select a color board, then add it to the workspace. You may do this in one of the following ways:

- Click \[\text{Video track}\] to add the color board to the Video track or \[\text{PiP track}\] to add the color board to the PiP track.
- Drag one or more color boards to a desired position in the Video or PiP track. When adding clips to the Video track, you cannot leave an empty gap between the last clip and the new clips you are adding. Clips added to the end of the Video track follow immediately after the final clip in that track.
Add Audio Clips

Using audio clips allows you to add background music or a narrative voice-over to your movie. PowerDirector provides two tracks for audio media (the Music and Voice tracks), which you can use interchangeably.

Note: Audio files can only be added to the workspace in Timeline view. If you drag an audio file to the workspace in Storyboard view, the workspace automatically switches to Timeline view.

To add an audio clip to the workspace, do this:

1. Click to open the Media Room in the Library.
2. Select Audio or All Media from the Filter drop-down list.
3. Select an audio clip, then add it to the workspace. You may do this in one of the following ways:
   - Click to add the audio clip to the Voice track or to add the audio clip to the Music track.
   - Drag one or more audio clips to a desired position in the Voice or Music track. Audio clips can be added at any point in this track.

Move a Clip in the Workspace

Once a clip has been added to the workspace, you can drag it to a different location on the track it is currently located in. However, you cannot drag clips between tracks.

Note: You may find moving media clips easier in Storyboard view, especially if the clip has an extremely short duration, or if you need to move it a relatively long distance over the workspace.
Chapter 4: Working with Media Clips

Cut/Copy/Paste a Clip in the Workspace

You can cut, copy, and paste media clips in PowerDirector’s workspace.

- Use the Ctrl key to select multiple, noncontiguous clips.
- Use the Shift key to select clips in a series.

When you paste, clips appear at the current position of the Timeline slider. If that position occurs within the duration of a media clip, the new clip is pasted immediately after that clip. If the Timeline slider is positioned in a gap between clips, the new clip is pasted and truncated (if necessary) to fit in the gap (PiP/Music/Voice tracks only). If the Timeline slider is positioned after the last clip, the new clip is pasted immediately after the last clip.

Remove a Clip from the Workspace

To remove a media clip from the workspace, select the clip(s) you want to remove, then do one of the following:

- Press the Delete key.
- Click Delete
- Right-click the clip, then select Delete.
Editing Clips

‘Editing’ is a broad term that encompasses a number of different functions: you can, for example, trim unwanted sections from video or audio clips, increase or decrease the speed of a video clip, or apply a special effect. This section describes all of the editing processes that you can perform on the different types of media clips.

Note: The functions in this section can only be performed in Timeline view.

Split a Clip

You can split a media clip into two clips at the current position of the Timeline slider. The procedure is the same for any type of media: audio, video, image, or color board.

To split a media clip, do this:

1. Select the clip you want to modify.
2. Place your cursor at the position at which you want to split the clip.
3. Click Split. The clip is split into two independent clips that can be moved or modified separately in the workspace.

Note: Splitting a video or audio clip does not delete any portion of the content. Both halves of a split video or audio clip can be stretched back to any length up to the original duration.
Trim a Video or Audio Clip

Video clips captured from external capture devices often contain unwanted portions at the beginning, between scenes, or at the end. These unwanted portions can easily be removed in PowerDirector using the Trim function.

Likewise, if you want to tailor your audio clip to fit the duration of a video clip, you can easily trim your audio clip to a desired length.

Note: Trimming a video or audio clip does not delete any portion of the content.

Trim Using the Trim Button

To trim a video or audio clip, do this:

1. Select the clip you want to modify.
2. Click Trim. The Trim option panel opens.

![Trim Option Panel](image)

3. Enter a mark in and mark out time. You may do this in one of the following ways:
   - Click inside the timecode box and enter a time using your keyboard.
   - Drag the mark in/mark out sliders to the correct time position.
   - Navigate to the desired time position using the playback buttons.
4. Click the Mark in and Mark out buttons.
5. Click to close the option panel.
Trim by Dragging an Edge

You can trim any kind of media clip in the Timeline (including audio, video, and image clips and color boards) by dragging either edge of that clip. You may find trimming a clip in this way easier if you first expand the ruler.

**Note:** Video and audio clips cannot be lengthened beyond their original duration.

To trim a media clip by dragging an edge, do this:

1. Select the clip you want to modify.
2. Position your cursor at one end of the clip and drag the end of the clip to the new position.

**Note:** You can drag the edge of a clip to lengthen it or to shorten it. If you compress the start of a video or audio clip, playback begins at a later frame within the clip. If you compress the ending, playback ends at an earlier frame within the clip.
Chapter 4: Working with Media Clips

Trim a Video Clip Using Precise Cut

If you need to trim video extremely accurately (for example at the frame level), use the Precise Cut feature in the Media Editor window. The Media Editor is a large, resizable preview window that offers a magnified timeline that is particularly useful for accurate trimming of longer videos.

To trim a video clip using the Precise Cut feature in the Media Editor, do this:

1. Select the clip you want to modify.
2. Click **Trim**.
   - Click **Clip** on the preview window, if necessary.
3. Click ****. The Media Editor window opens.
4. Click **** to enable the Precise Cut magnifier, then click **** to zoom the timeline in or **** to zoom out.
5. Enter a mark in and mark out time. You may do this in one of the following ways:
   - Click inside the timecode box and enter a time using your keyboard.
   - Drag the mark in/mark out sliders to the correct time position.
   - Use the playback buttons.
   **Note:** Drag the bottom slider for more precise control.
6. Click the Mark in and Mark out buttons.
7. Click **** or press the **<Esc>** key to close the Media Editor window.
Take a Still Snapshot of a Video Clip

You can capture a single frame from a video clip and automatically load the snapshot in the Library.

To take a snapshot of a video clip, do this:

1. Select the clip you want to modify.
2. Click Trim.
3. Navigate to the frame you want to capture using the playback buttons.
4. Click Snapshot. The frame is captured and stored in the Library as an image file.

Change the Speed of a Video Clip

Slow-motion or fast-motion effects can grab your audience’s attention as well as break up the rhythm of a movie.

Note: Video clips can be located in either the Video or PiP track.

To change the speed of a video clip, do this:

1. Select the clip you want to modify.
2. Click Speed. The speed option panel opens.

3. Set the new speed (between .5x and 2x). You may do this in one of two ways:
   - Drag the slider to increase or decrease the speed.
   - Enter a timecode in the New video length box. (This method allows more accurate control, as you can specify a length down to the frame level.)
4. Click to close the option panel.
Chapter 4: Working with Media Clips

Stretch the Audio Portion of a Video Clip

When you alter the speed of a video clip, you may wish to stretch the audio portion at the same proportion as the video portion.

To change the speed of a video clip, do this:

1. Select the clip you want to modify.
2. Click Speed. The speed option panel opens.
3. Click Stretch Audio. This option stretches the video clip’s audio portion (between .5x and 2x). The pitch of the audio portion remains unchanged to avoid unexpected audio results.
4. Click to close the option panel.

Mute the Audio Portion of a Video Clip

When you alter the speed of a video clip, you may wish to mute the audio portion in order to avoid unintended audio effects.

To change the speed of a video clip, do this:

1. Select the clip you want to modify.
2. Click Speed. The speed option panel opens.
3. Click Mute Audio. This option silences the video clip’s audio portion during playback (between .1x and 10x).
4. Click to close the option panel.
Change the Color of a Visual Media Clip

You may wish to change the color attributes of a video or image clip or a color board in order to produce a surprising effect, or simply to emulate reality more closely. Either result is easy to achieve in PowerDirector.

To change the color of a visual media clip, do this:

1. Select the clip you want to modify.
2. Click **Color**. The color option panel opens.

![Color Option Panel]

3. Set the color options that you want to apply:
   - **Brightness**: the brightness/darkness of the image
   - **Contrast**: the difference in proportion between lights and darks in the image
   - **Hue**: the individual colors in the image
   - **Saturation**: the depth of the colors in the image
   - **Sharpness**: the clarity of details in the image

4. Click **OK** to close the option panel.
Chapter 4: Working with Media Clips

Set a Video Clip’s Interlacing Format

All video clips have an interlacing (TV) format, which specifies how frames are displayed. Using video clips with conflicting (or incorrect) TV formats can result in degraded video quality in your final production.

Before you produce your movie, set all of the video clips to the same format. (You do not need to know what the format of each clips is, as PowerDirector can detect this for you.) While PowerDirector can normally detect and suggest the correct format, some interlaced video (such as a video with very little motion) may be misjudged as a progressive video. PowerDirector automatically produces interlaced video for DVD, SVCD, and DV-AVI. Only change this setting if you are sure that PowerDirector has wrongly set the format.

**Note:** This is an extremely important step to take before production, as it can drastically affect final video quality!

To set a video clip’s TV format, do this:

1. Right-click the video clip whose interlacing format you want to set and select **Set TV format**. The Interlace and Progressive Settings dialog box opens.

2. Select an interlacing option:
   - If you know the interlacing format you want to use, select the corresponding option
   - If you do not know the interlacing formation you want to use, select **Scan and Suggest Format**. PowerDirector scans the clip and automatically selects the best format.

3. Click **OK**.
Change Audio Clip Volume Levels

Your movie may contain audio portions in the Music track, the Voice track, as well as in the video clips you have added. Since all of these tracks have probably been recorded at different levels, the result of so many audio sources can produce an overwhelming and confusing sound track. However, the audio levels of all of these different tracks can be mixed to produce a more harmonious sound track to your movie. Audio levels can be mixed in the audio mixer or inside the audio clips in the Music and Voice tracks.

In-Track Audio Mixing

You can change the level of volume at any point within an audio clip in the Timeline.

To change the volume level of an audio track in the Timeline, do this:

1. Select the clip you want to modify.
2. Click on the audio level line at the point where you want to change the audio level to set a volume key. Drag the volume key up to increase the volume or down to decrease the volume.

- Set levels at fewer volume keys along the track for subtler changes in volume, or more volume keys for more extreme changes in volume.
- To remove a volume key, drag it outside the clip’s borders.
Mix Audio Levels in the Audio Mixer

Using the Audio Mixer gives you very precise control over the volume levels of the audio clips in the workspace.

To mix audio in the Audio Mixer, do this:

1. Click 🎧. The Audio Mixer opens.
2. Click  Play.  
3. Use the sliders to mix the volume levels of the corresponding tracks.
   • Use the vertical sliders to set volume keys to increase or decrease the volume of the track on the fly.
   • Use the horizontal sliders to increase or decrease the volume of the entire track.
4. Click  to close the Audio Mixer.

Add a Fade Effect to an Audio Clip

To add a fade-in/fade-out effect to an audio clip, do this:

1. Click 🎧. The Audio Mixer opens.
2. Click the button corresponding to the type of fade effect you want:
   • Click 🎧 to add a fade-in effect.
   • Click 🎧 to add a fade-out effect.
3. Click  to close the Audio Mixer.
**Mute an Entire Audio Clip**

You may wish to mute the audio output of an entire track. To do this, right-click the track and deselect **Mute track**. Any audio volume keys you have added are hidden.

To unmute the track, right-click the track and select **Mute track**. The audio volume keys you have added are restored.

**Restore an Audio Clip’s Volume Levels**

If you are dissatisfied with the volume level of any audio clip after manually setting volume keys, you can easily restore the clip’s original volume level. To do this, right-click the track and select **Restore original volume level**. Any audio volume keys you have added are permanently removed.
Preview a Clip

As you add media to your production, it is important to preview the effect your media clips have on the story you are telling. You may want to preview imported clips, for example, to verify their content, or to preview clips you have captured to see if they contain sections you need to trim.

Preview a Clip in the Preview Window

The easiest way to preview a media clip is by playing it in the preview window. Any media clip that appears in the Library or the workspace can be previewed in this window. However, playback controls are only available for video and audio media.

To preview a media clip in the preview window, do this:

1. Click the clip or effect you want to preview. The clip appears in the preview window.

2. Locate the point at which you want to begin your preview. You may do this in one of the following ways:
   - Drag the Timeline slider.
   - Drag the preview window slider.
   - Enter a timecode in the timecode box.

3. Press Play. The preview starts from the point you have specified.
4. Use the playback buttons to control the preview.

Note: When previewing clips in the workspace, ensure that the preview window is in Clip mode. If the preview is in Movie mode, click the Clip button before previewing a clip.
Preview a Clip in the Media Viewer

Previewing clips in the Media Viewer gives you a larger preview picture than the preview window.

To preview a clip in the Media Viewer, do this:

1. Right-click the clip in the Library.
2. Select Play in Media Viewer. The clip appears in the Media Viewer.

3. Locate the point at which you want to begin your preview. You may do this in one of the following ways:
   - Drag the Timeline slider.
   - Drag the preview window slider.
   - Enter a timecode in the timecode box.

4. Press Play. The preview starts from the point you have specified.
5. Use the playback buttons to control the preview.

Note: Use the slider in the magnified timeline for more precise preview control.
Chapter 5:

Working with Effects

Working with effects is probably the most exciting part of video editing, as you can radically change the appearance of media clips or tastefully transition from one scene to another. You can add many different types of effects to clips in the Timeline, including video effects, title effects, PiP (picture-in-picture) effects, and video transition effects.

This chapter contains the following sections:

- Managing Effects in the Library on p.70
- Managing Effects in the Timeline on p.72
- Modifying Effects on p.75
Managing Effects in the Library

You can restrict the display of the numerous effects found in PowerDirector to a certain type of effect for a simpler view, and you can create a Favorites category in which you can store the effects you use most frequently.

Since PiP effects contain video or image clips, they are added to the workspace and managed like media clips. For information on managing clips in a PiP effect, see Managing Clips in the Workspace on p.52.

Note: The number and type of PowerDirector’s effects vary, depending on version. For information on the availability of specific features in the PowerDirector version that you are using, please check the Readme file.

Sort Effects in the Library

To change the way effects are sorted, click , then select Sort by. You can sort the effects by Name or Type.

Restrict the Display of Effects

To restrict the display of effects in the Library, select the type of effect you want to view from the Filter drop-down list. Only those clips that belong to the media type you have selected are displayed in the Library.
Add an Effect to My Favorites

You can add video, title, and transition effects to the Favorites category for quicker access to the effects you use most frequently. To add an effect to the Favorites category, right-click the effect, then select Add to Favorites. When you select My Favorites from the Filter drop-down list, only the effects you have specifically added to this category appear.

Remove an Effect from My Favorites

To remove an effect from the Favorites category, select My Favorites from the Filter drop-down list. Right-click the effect, then select Remove from Favorites. The effect no longer appears in the My Favorites category.
Managing Effects in the Timeline

Effects are added to tracks in the Timeline that are specific to each type of effect. (Effect tracks cannot contain effects of any other kind, nor can they contain media clips.) This section describes how to add effects to the proper track and how to manage effects once they have been added to the Timeline.

Note: Since PiP effects contain video or image clips, they are added to the workspace and managed like media clips. For information on managing clips in a PiP effect, see Managing Clips in the Workspace on p.52.

Add a Video/Title/Transition Effect

The procedure below describes how to add video, title, and transition effects to the Timeline.

To add a video/title/transition effect to the Timeline, do this:

1. Click an effect button to display the type of effect you want to add in the Library.
2. Select an effect from the Library and drag it into the desired position in the correct track. (This position is directly beneath the clip(s) in the Video track that you want to affect.)
   - When a video or title effect is selected, you may click a button located below the Library to add the effect to the appropriate track at the current position of the Timeline slider.
   - You can randomly add an effect at the current position of the Timeline slider. Click , then select the random option.
   - Transition effects are randomly applied between all of the clips currently in the Timeline.
Replace an Effect in the Timeline

You can replace any effect in the Timeline with a different effect that you select in the Effect Room without having to delete one effect and add another.

To replace an effect in the Timeline, do this:

1. Position the Timeline slider on the effect that you want to replace.
2. Click to open the Effect Room.
3. Right-click a new effect in the Effect Room, then select Add/Replace in Timeline. The new effect replaces the effect in the Timeline.

Delete an Effect

The procedure below describes how to delete a Video, Title, PiP, or Transition effect from the Timeline.

To delete an effect, do this:

1. Select the effect you want to delete.
2. Delete the effect. You may do this in one of the following ways:
   - Press the Delete key.
   - Click .
   - Right-click the effect, then select Delete.
Move an Effect in the Workspace

Once an effect has been added to the workspace, you can drag it to a different location on the track it is currently located in. However, you cannot drag clips between tracks.

Cut/Copy/Paste an Effect in the Workspace

You can cut, copy, and paste effects in PowerDirector’s workspace. Use the Ctrl key to select multiple, noncontiguous effects or the Shift key to select effects in a series. When you paste, effects appear at the current position of the Timeline slider. If that position occurs within the duration of another effect, the new effect is pasted immediately after that effect. If the Timeline slider position is located in a gap that contains no effects, the new effect is pasted and truncated (if necessary) to fit in the gap.
Modifying Effects

Most effects boast a number of options that you can set individually to increase or decrease the intensity of the effect, or to achieve more creative results. In fact, this section describes some of the most creative functions found within the PowerDirector program. Mastering the procedures found in this section will go a long way towards making you a digital video editing expert!

Set an Effect’s Hold Time

Some effects (title and PiP effects in particular) contain inherent motion, moving across the screen as they affect the video in your movie. You can set the relative amount of time the effect remains still onscreen between its arrival and departure in both the preview window and the Media Editor.

To set an effect’s hold time, do this:

1. Set a title or PiP effect.
2. Click the effect in the Timeline.
3. Preview it in either the preview window or the Media Editor. For more information on the preview window, see Preview an Effect in the Preview Window on p.91. For more information on the Media Editor, see Preview an Effect in the Media Editor on p.92.
4. Drag the Mark in and Mark out sliders to set the effect’s hold time. (The orange bar represents the hold time.)
Split a Video, Title, or PiP Effect

You can split an effect into two sections at the current position of the Timeline slider. The procedure is the same for video, title, and PiP effects. Transition effects cannot be split.

To split an effect, do this:

1. Select the effect you want to split.
2. Navigate to the point at which you want to split the effect. (You can do this by dragging the Timeline slider or by using the slider and navigation controls in the preview window.)
3. Click Split.

Set an Effect’s Duration

The procedure below describes how to set the duration of a video, title, or transition effect. The procedure for PiP effects has only a slight difference.

Set an Effect’s Duration Using the Duration Setting Box

To set an effect’s duration using the Duration Setting box, do this:

1. Select the effect you want to modify.
2. Display the timecode box. You may do this in one of the following ways:
   - Video/title/transition effects: Click Duration. The Duration Setting dialog opens.
   - PiP effects: Click Trim. The PiP Trim Options panel opens, displaying the timecode box in the upper right-hand corner.

   Note: To set a PiP effect’s duration using the Trim options, see Trim a Video or Audio Clip on p.57.

3. Set the duration, then do one of the following:
   - Video/title/transition effects: Click OK.
   - PiP effects: Click to close the options panel and return to the normal Library view.
Set an Effect’s Duration Manually

You can set an effect’s duration manually by dragging the edges of the effect in the Timeline. The procedure for dragging the edges of an effect is the same for video, title, PiP, and transition effects.

**Note:** Video clips used in a PiP cannot be lengthened beyond their original duration. Transitions can be lengthened to half of the duration of the shortest clip they affect.

To set an effect’s duration manually, do this:

1. Select the effect whose duration you want to set manually.
2. Position your cursor at one end of the effect and drag the end of the clip to the new position.

**Note:** You can drag the edge of a clip to lengthen it or to shorten it. If you compress the start of a video or audio clip, playback begins at a later frame within the clip. If you compress the ending, playback ends at an earlier frame within the clip.
Modifying a Video Effect

Video effects are applied to the Effect track at the time position of the video or image clip(s) that you want to affect. Video effects only affect the clips in the Video track that appear within the effect’s duration.

To modify a video effect, do this:

1. Select the video effect in the Effect track and click **Modify**. The Effect Modifications Options panel opens.

2. Set the intensity level of the video effect. A preview of the effect appears in the preview window. (Options vary according to the video effect you select.)
   - Many options provide a slider to increase or decrease the intensity of the effect.
   - Some effects provide a drop-down list in which you can choose an effect option.
   - Click ![button](image) to change two settings in proportion with each other.
   - Click **Reset** to restore the original effect settings.

3. Click ![button](image) to close the options panel and return to the normal Library view.
Modifying a PiP Effect

A picture-in-picture effect allows you to insert an image or a video into an existing image or video clip in your movie, effectively overlaying the picture-in-picture clip on top of the existing clip. You can modify the degree of transparency of the overlapping clip, as well as its position, motion, and other properties.

PiP effects have many options that you can modify independently. These include a border, a shadow, a motion effect, a color filter, size and position, and transparency.

Change the Speed of a PiP Effect

Slow-motion or fast-motion effects can grab your audience’s attention as well as break up the rhythm of a movie.

To change the speed of a PiP effect, do this:

1. Select the PiP effect video clip that you want to modify.
2. Click Speed. The speed option panel opens.
3. Drag the slider to set the new speed (between .1x and 10x).
4. Click to close the option panel.
Add a Border to a PiP Effect

You can add a border around the clip in a PiP effect. Available options allow you to change the border’s color and size and to add a transparency or blur effect.

To change the border of a PiP effect, do this:

1. Select the PiP effect video clip that you want to modify, then click **Modify**. The PiP Modification Options panel opens.
2. Click . The PiP Designer opens.
3. Set the PiP border options that you want to apply:

   **Apply border**  
   Check to apply the font face settings. Uncheck to remove the font face settings.

   **Size**  
   Drag the slider to increase or decrease the size of the border.

   **Blur**  
   Drag the slider to increase or decrease the blur effect of the border.

   **Transparency**  
   Drag the slider to increase or decrease the transparency of the border.

   **Uniform color**  
   Check to set the border in a single color. Click the eyedropper to open the Color dialog box, in which you can select a color.

   **Gradient color**  
   Check to set the border in a color gradient.
Chapter 5: Working with Effects

Begin

Click the eyedropper to open the Color dialog box, in which you can select the color at the start of the gradient.

End

Click the eyedropper to open the Color dialog box, in which you can select the color at the end of the gradient.

Gradient direction

Click a dimple to indicate the direction of the gradient.

Note: Whenever you set an option in the PiP Designer, a preview of the effect is instantly displayed.

4. Click OK to close the PiP Designer.

Add a Shadow to a PiP Effect

You can add a shadow around the clip in a PIP effect. Available options allow you to change the shadow’s color and size and to add a transparency or blur effect.

To add a shadow to a PiP effect, do this:

1. Select the PiP effect video clip that you want to modify, then click Modify. The PiP Modification Options panel opens.
2. Click . The PiP Designer opens.
3. Set the PiP shadow options that you want to apply:

**Apply shadow**  Check to apply the shadow settings. Uncheck to remove the shadow settings.

**Distance**  Drag the slider to increase or decrease the distance between the shadow and the font face.

**Blur**  Drag the slider to increase or decrease the blur effect of the shadow.

**Transparency**  Drag the slider to increase or decrease the transparency of the shadow.

**Fill shadow**  Check to fill in the gap between the shadow and the font face.

**Color picker**  Click the eyedropper to open the Color dialog box, in which you can select the color of the shadow.

**Shadow direction**  Click a dimple to indicate the direction of the shadow.

**Note:** Whenever you set an option in the PiP Designer, a preview of the effect is instantly displayed.

4. Click **OK** to close the PiP Designer.
Add Motion to a PiP Effect

You can add a motion to the clip in a PiP effect. Available options allow you to set the start and end locations, add a fade-in or fade-out, and begin or end the effect off screen.

To add motion to a PiP effect, do this:

1. Select the PiP effect video clip that you want to modify, then click **Modify**. The PiP Modification Options panel opens.
2. Click . The PiP Designer opens.
3. Set the PiP motion options that you want to apply:

   **PiP starting position** Select the position at which you want the PiP clip to begin its motion from the drop-down list. (Select **Still** if you do not want the PiP clip to move at the beginning of the effect.)

   **Start off screen** Check this option if you want the PiP clip to begin off screen.

   **Fade-in** Check this option if you want the PiP clip to fade in at the beginning of the effect.

   **PiP ending position** Select the position at which you want the PiP clip to end its motion from the drop-down list. (Select **Still** if you do not want the PiP clip to move at the end of the effect.)
Note: Whenever you set an option in the PiP Designer, a preview of the effect is instantly displayed.

4. Click **OK** to close the PiP Designer.

**Add a Color Filter to a PiP Effect**

When you add a color filter to a clip in a PiP effect, portions of the underlying clip show through the overlaid clip wherever the selected color occurs.

To add a color filter to a PiP effect, do this:

1. Click the media clip in the PiP track you want to modify, then click **Modify**. The PiP Modification Options panel opens.

2. Check **Apply color filter**. This filters the selected color out of the image (i.e.: makes that color transparent).
3. Click the eyedropper tool. A dialog box opens, in which you can select a color from the media clip in your PiP effect.

![Choose a Color to be Filtered dialog box]

4. Select the color from the clip that you would like to make transparent, then click OK.
   * To select more accurately, you can zoom in or out of the image. To do this, click select a magnification percentage from the drop-down list, then click the button to zoom in or the button to zoom out.

![Choose a Color to be Filtered dialog box with magnification]

5. Set a Tolerance level to extend or restrict the range of colors affected by the filter. You may do this in one of the following ways:
   * Drag the Tolerance level slider.
   * Click the button to increase the level or the button to decrease the level.

6. Click to close the options panel and return to the normal Library view.
Modify a PiP Effect’s Size and Position

You can change both the size and the position of the media clip in a PiP effect. Resizing options are unrestricted. You can reduce the clip to miniature size or enlarge it to completely obscure the underlying media file.

To modify a PiP effect’s size and position, do this:

1. Click the media clip in the PiP track, then click Modify. The PiP Modification Options panel opens.
2. Modify the PiP clip’s size and position:
   - Drag the PiP clip to a desired location over the underlying clip.
   - Drag the edge of the PiP clip to a desired size. Check Keep aspect ratio to constrain the ratio of the length and width of the PiP clip. Uncheck this option to change the aspect ratio freely.
3. Click ➡ to close the options panel and return to the normal Library view.

Modify a PiP Effect’s Transparency Level

You can modify the transparency level of the media clip in a PiP effect. Transparency options range from entirely transparent to totally opaque.

To modify a PiP effect’s transparency level, do this:

1. Click the media clip in the PiP track, then click Modify. The PiP Modification Options panel opens.
2. Set the Transparency level to increase or decrease the transparency of the superimposed clip.
3. Click ➡ to close the options panel and return to the normal Library view.
Modify a Title Effect

Using title effects allows you to add text to your movie - as a title at the beginning, an element during the main story, or as credits at the very end. Besides changing the look of the text itself, you can also send the text running on a path across the screen. Title effects only affect the clips in the Video track that appear within the effect’s duration.

Title effects contain font face and shadow options, which you can modify to best suit your movie. All of these options are found in the Title Designer.

Modify a Title Effect’s Font Face

You can modify the font used in a title effect, including the size, color, font type used, weight, alignment, transparency, and blur effect. Further tools aid in the precise positioning of the title on the screen and indicate the on-screen area that is safe for TV display.

1. Select a title effect in the Title track, then click Modify. The Title Designer opens.

2. Set the text font face options that you want to apply:

Click to select a title effect.

Click to select a font type.
Click to select a font size.

Click to make text bold.

Click to make text Italicized.

Click to left-align text.

Click to center-align text.

Click to right-align text.

Click to add/remove a title mask.

Click to add/remove grid lines that can aid in the precise positioning of text on the screen. Grid lines do not appear when you preview or produce your movie.

Click to add/remove the TV Safe Zone outline, which represents the area in which video content from your movie is certain to appear on TV screens, which have a smaller display area than computer monitors. The TV Safe Zone outline does not appear when you preview or produce your movie.

Apply font face
Check to apply the font face settings. Uncheck to remove the font face settings.

Blur
Drag the slider to increase or decrease the blur effect of the font face.

Transparency
Drag the slider to increase or decrease the transparency of the font face.

Uniform color
Check to set the font face in a single color. Click the eyedropper to open the Color dialog box, in which you can select a color.

Gradient color
Check to set the font face in a color gradient.
Chapter 5: Working with Effects

Begin

Click the eyedropper to open the Color dialog box, in which you can select the color at the start of the gradient.

End

Click the eyedropper to open the Color dialog box, in which you can select the color at the end of the gradient.

Gradient direction

Click a dimple to indicate the direction of the gradient.

Note: Whenever you set an option in the Title Designer, a preview of the effect is instantly displayed.

3. Click **OK** to close the Title Designer.

Mask a Title Effect

Masking a title effect hides the portion of the title effect that is located within the mask.

To mask a title effect, do this:

1. Select a title effect in the Title track, then click **Modify**. The Title Designer opens.
2. Click 

   Bars appear around the perimeter of the clip.
3. Drag the title mask bars to specify the area you want to mask. Any text that appears outside this area does not appear when the clip is played.

4. Click **OK** to close the Title Designer.
Add a Shadow to a Title Effect

You can add a shadow around the text in a title effect. Available options allow you to change the shadow’s color and size and to add a transparency or blur effect.

1. Click \( \text{Add} \) to open the Shadow settings.

2. Set the text shadow options that you want to apply:

   - **Apply shadow**: Check to apply the shadow settings. Uncheck to remove the shadow settings.
   - **Distance**: Drag the slider to increase or decrease the distance between the shadow and the font face.
   - **Blur**: Drag the slider to increase or decrease the blur effect of the font face.
   - **Transparency**: Drag the slider to increase or decrease the transparency of the font face.
   - **Fill shadow**: Check to fill in the gap between the shadow and the font face.
   - **Color picker**: Click the eyedropper to open the Color dialog box, in which you can select the color of the shadow.
   - **Shadow direction**: Click a dimple to indicate the direction of the shadow.

3. Click **OK** to close the Title Designer.
Preview an Effect

Previewing effects is an important step in ensuring not only that the effect is applied to the proper clip in the proper location, but that the intensity of the effect is suitable for that location in the movie. You will likely preview effects constantly as you apply them to the workspace, and it is a good idea to preview your movie at regular intervals to ensure that your editing is proceeding as you planned.

Preview an Effect in the Preview Window

To preview an effect in the preview window, do this:

1. Click the effect in the Timeline. The media clip the effect is applied to appears in the preview window.

2. Locate the point at which you want to begin your preview. You may do this in one of the following ways:
   - Drag the Timeline slider.
   - Drag the preview window slider.
   - Enter a timecode in the timecode box.

3. Press Play. The preview starts from the point you have specified.

4. Use the playback buttons to control the preview.
Preview an Effect in the Media Editor

The Media Editor is a resizable preview window that offers a larger screen than the preview window, a zoomable timeline, and the ability to add mark in and mark out points for effects.

To preview an effect in the Media Editor, do this:

1. Click the effect in the Timeline.
2. Click . The Media Editor opens.

3. Locate the point at which you want to begin your preview. You may do this in one of the following ways:

   • Drag the Timeline slider.
   • Drag the preview window slider.
   • Enter a timecode in the timecode box.

4. Press Play. The preview starts from the point you have specified.

5. Use the playback buttons to control the preview.

Note: Use the slider in the magnified timeline for more precise preview control.
Chapter 6: Producing Your Movie

After your movie has been completely edited, you are ready to produce your movie. Producing a movie simply means compiling (or rendering) the separate elements it contains into one playable movie file. As your movie can be destined for different uses, PowerDirector has several options to produce movies suited to any need.

Note: Before producing your movie, make sure that all of your video clips have the same interlacing format. This is an extremely important step to take before production, as it can drastically affect final video quality! If you produce your movie and find the video quality unsatisfactory, verify that the interlacing format of all of your video clips is the same. If your clips have different interlacing formats, set them all to the same format, then produce your movie again. For more information, see Set a Video Clip’s Interlacing Format on p.63.

This chapter contains the following sections:

- Preview Your Movie on p.94
- The Production Wizard on p.96
- Produce a Disc on p.97
- Create a File on p.101
- Create a Streaming File on p.112
- Write Back to DV Tape on p.120
Preview Your Movie

Before you commit your movie to disc, it’s a good idea to preview it to make sure all of your clips and effects are working to create the movie you want. It is highly recommended that you preview your movie at least once before production so you can solve problems without spending time unnecessarily in production.

Preview Your Movie in the Preview Window

You can preview your movie at any point during the editing process in order to ensure that your editing is going smoothly. Using the Timeline slider, you can preview your movie production from any point within the Timeline.

Note: When previewing clips in the workspace, ensure that the preview window is in Movie mode. If the preview is in Clip mode, click the Movie button before previewing your movie production.

1. Click the Movie button in the preview window.
2. Locate the point at which you want to begin your preview. You may do this in one of the following ways:
   - Drag the Timeline slider.
   - Drag the preview window slider.
   - Enter a timecode in the timecode box.
3. Press Play. The preview starts from the point you have specified.
4. Use the playback buttons to control the preview.
Preview Your Movie in the Media Viewer

To preview your movie in the Media Viewer, do this:

1. Click the Movie button in the preview window.
2. Click . The Media Viewer opens.

- You may drag an edge or a corner to resize the Media Viewer window.
4. Use the playback buttons to control the preview.
The Production Wizard

The Production Wizard is a simple interface that makes movie production easy. When you click 

![The Production Wizard interface](image)

The opening window contains a preview window, a visual display of your hard disk space, and four buttons corresponding to the four production options available in The Production Wizard. These are described below:

**Produce a Disc**: Allows you to create a movie production that you can then burn to disc. See Produce a Disc on p.97.

**Create a File**: Allows you to create a movie production that you can then watch on your computer. See Create a File on p.101.

**Create a Streaming File**: Allows you to create a movie production that you can then stream over the Internet. See Create a Streaming File on p.112.

**Write Back to DV Tape**: Allows you to create a movie production that you can then write back to DV tape. See Write Back to DV Tape on p.120.
Chapter 6: Producing Your Movie

Produce a Disc

You may want to burn your movie to disc so that you and your friends and family can enjoy watching it on a computer or a disc player. This section describes how to produce a movie that you can burn to disc after the production process is finished.

To produce a movie that you can burn to disc, do this:

1. Click to open the Production Wizard.

2. Click , then Next. Disc production options appear on the page.

3. Select a disc format, then set your options:
   - To set a destination folder for the produced movie, click Output to, then choose a new folder.
   - Country/Video Format of Disc: Specify the location where you want to play the disc you create.
   - Profile: Select a profile category (Default, Custom, or All) from the Profile drop-down, then a specific profile from the drop-down to the right. For more information on production profiles, see Create a New MPEG-1/ MPEG-2 Profile on p.99.
- **Use SVRT to save rendering time**: Keep this option checked (when it is enabled) to reduce production time. For more information on SVRT, see What is SVRT/SVRT II and when can I use it? on p.136 and SVRT, SVRT II on p.148.

- **After production, make disc in PowerProducer**: Check this option if you want to continue the production process by burning a disc in PowerProducer after your movie is compiled.

4. Click **Next**. Production details appear on the page.

5. Verify that these details are correct.

   - You can change the video file name and destination folder. To do this, click , then enter a new name or locate a new folder.

   - To ensure that all of your video clips have the same interlacing format, click **Scan source video clips and set field order**.

   **Note**: This is an extremely important step to take before producing your final movie, as it can drastically affect final video quality!

6. Click **Start**. The production process begins. This process may take a few minutes.

   - To stop the production process before completion, click **Abort**.

   - To return to Edit mode after production is complete, click **Home**.
Create a New MPEG-1/MPEG-2 Profile

MPEG production profiles can be used when you produce a movie for a disc or when you create an MPEG-1 or MPEG-2 file. You can create custom production profiles if none of the existing profiles suit your specific production requirements.

To create a new custom production profile, do this:

1. Click . The Profile Setup dialog box appears.

2. Enter a new profile name.
3. Click the Video tab and modify the video options, if necessary:

   - **Video Size**: Select a video display size from the drop-down list.
   - **Video Compression Bitrate**: Drag the slider to increase or decrease video bitrate. An increased bitrate (set by dragging the slider to the right) results in a larger file size and increased production time.
• **Smoothing**: Check to produce a softer video image. Only use this option if it was not used during capture, as it can result in slightly blurred video quality.

• **Noise removal**: Check to remove video artefacts. Only use this option if it was not used during capture, as it can result in slightly blurred video quality.

• **Deinterlacing**: Check to create deinterlaced video. Deinterlacing improves the quality of interlaced video when displayed on a computer monitor, but does may degrade video quality in other cases.

• **High speed/High quality**: Drag the slider to select an acceptable setting between faster production speed with lower video quality and higher video quality with slower production speed.

4. Click the Audio tab and modify the audio option, if necessary:

   - **Audio Compression Rate**: Select a rate from the drop-down list. A higher rate yields better audio quality, but results in a larger file and increased production time.

5. Click **OK** to close the dialog box.

   - To edit a custom production profile, click **Edit** and edit the necessary information.
   - To delete a profile, click **Delete**. A warning message appears, asking if you want to delete the profile. Click **OK**. The profile is deleted.
   - To view a profile’s production details, select the profile whose details you want to view, then click **Details**. The Details dialog appears, displaying the profile’s details. Click **OK** to close the dialog.
Create a File

You may want to produce your movie as a file that you can watch on your computer. PowerDirector allows you to create files in AVI, MPEG-1, or MPEG-2 format. The procedures for creating each of these file types are described in the section below.

Create an AVI File

There are two types of AVI files: DV-AVI or Windows AVI.

DV-AVI

To produce an AVI movie that you can watch on your computer, do this:

1. Click to open the Production Wizard.
2. Click , then Next. File generation production options appear on the page.
3. Select the AVI file format.
4. Select the DV-AVI format from the drop-down list.
5. Select **NTSC** or **PAL** from the drop-down list.
   
   - **Use SVRT to save rendering time:** Keep this option checked (when it is enabled) to reduce production time. For more information on SVRT, see What is SVRT/SVRT II and when can I use it? on p.136 and SVRT, SVRT II on p.148.

6. Click **[ ]**. A dialog box opens. Set your options, if necessary:

   ![AVI Production Profile Settings dialog box]

   - Select **Type I** or **Type II**. For more information on these two types, see Type I and Type II on p.148.
   - Select **High Quality** or **Medium Quality**. For more information on video quality, see Video Quality on p.142.
   - To review your production settings, click **[ ]**. A dialog box opens, in which you can verify the profile’s details.
7. Click **Next**. Production details appear on the page. Verify that these details are correct.

- You can change the video file name and destination folder. To do this, click **...**, then enter a new name or locate a new folder.
- To ensure that all of your video clips have the same interlacing format, click **Scan source video clips and set field order**.

8. Click **Start**. The production process begins. This process may take a few minutes.

- To stop the production process before completion, click **Abort**.
- To return to Edit mode after production is complete, click **Home**.
CyberLink PowerDirector

Windows AVI

To produce an AVI movie that you can watch on your computer, do this:

1. Click to open the Production Wizard.
2. Click , then Next. File generation production options appear on the page.

3. Select the AVI file format.
4. Select the Windows AVI format from the drop-down list.
5. Select a video quality from the drop-down list.
6. Click . A dialog box opens. Set your options, if necessary:
Chapter 6: Producing Your Movie

- **Compression**: Select a codec from the drop-down list.
- **Key Frame**: This field, when available, allows you to set the number of key frames in your video, but this number cannot be set for most codecs. For more information on key frames, see key frame on p.146.
- **Data rate**: Select a data rate from the drop-down list.
- **Composition**: Select the media type to be compressed in your final movie production: **Video and audio**, **Video only**, or **Audio only**.
- The **Codec Settings...** and **About** buttons open dialog boxes with options and information about the individual compression/decompression schemes.
- **Better Compression/Better Quality**: Drag the slider to select a setting between smaller production file size and better video quality.

Click the Video/Audio Settings tab and set your options, if necessary:

- **Frame(s)**: Select a frame rate from the drop-down list.
- **Video Size**: Select a video display size from the drop-down list.
- **Colors**: Select a color scheme from the drop-down list.
- **Format**: Select an audio format from the drop-down list.
- **Attributes**: Select audio attributes from the drop-down list.
To verify the profile’s properties, click . A dialog box opens, in which you can verify the profile’s details.

7. Click Next. Production details appear on the page. Verify that these details are correct.

You can change the video file name and destination folder. To do this, click , then enter a new name or locate a new folder.

To ensure that all of your video clips have the same interlacing format, click **Scan source video clips and set field order**.
8. Click **Start**. The production process begins. This process may take a few minutes.
   - To stop the production process before completion, click **Abort**.
   - To return to Edit mode after production is complete, click **Home**.
Create a DivX File

You can create a DivX file for a number of different uses: as an email attachment, for playback on a media player, for viewing on a TV, or for writing to VHS tape.

To produce a DivX movie, do this:

1. Click to open the Production Wizard.
2. Click then Next. File generation production options appear on the page.
3. Select the DivX file format.
4. Click **Next**. Production details appear on the page. Verify that these details are correct.

   ![Production Details](image)

   - You can change the video file name and destination folder. To do this, click `...`, then enter a new name or locate a new folder.
   - To ensure that all of your video clips have the same interlacing format, click **Scan source video clips and set field order**.

5. Click **Start**. The production process begins. This process may take a few minutes.
   - To stop the production process before completion, click **Abort**.
   - To return to Edit mode after production is complete, click **Home**.
Create an MPEG1/MPEG2 File

To produce an MPEG1/MPEG2 movie that you can watch on your computer, do this:

1. Click to open the Production Wizard.
2. Click , then Next. File generation production options appear on the page.
3. Select the MPEG-1/MPEG-2 file format, then select a profile. For more information on profiles, see Create a New MPEG-1/MPEG-2 Profile on p.99.
4. Click **Next**. Production details appear on the page. Verify that these details are correct.

   ![Image of production interface]

   - You can change the video file name and destination folder. To do this, click ..., then enter a new name or locate a new folder.

5. Click **Start**. The production process begins. This process may take a few minutes.

   - To stop the production process before completion, click **Abort**.
   - To return to Edit mode after production is complete, click **Home**.
Create a Streaming File

You may want to produce your movie as a video file that can be stored on a server for streaming over the Internet. PowerDirector allows you to create files in WMV, RealVideo, or QuickTime Movie format. The procedures for creating each of these file types are described in the section below.

Create a WMV File for Streaming

To produce a WMV movie that you can stream over the Internet, do this:

1. Click to open the Production Wizard.
2. Click , then Next. Streaming file production options appear on the page.
3. Select the WMV movie file format.
4. Select the movie setting that suits your production needs.
5. Click **Next**. Production details appear on the page. Verify that these details are correct.
   - You can change the video file name and destination folder. To do this, click ..., then enter a new name or locate a new folder.
   - To ensure that all of your video clips have the same interlacing format, click **Scan source video clips and set field order**.

   **Note:** This is an extremely important step to take before producing your final movie, as it can drastically affect final video quality!

6. Click **Start**. The production process begins. This process may take a few minutes.
   - To stop the production process before completion, click **Abort**.
   - To return to Edit mode after production is complete, click **Home**.
Create a RealVideo File for Streaming

To produce a RealVideo movie that you can stream over the Internet, do this:

1. Click to open the Production Wizard.
2. Click , then Next. Streaming file production options appear on the page.
3. Select the RealVideo movie file format.

4. Enter the file’s properties:
   - **Title**: Enter a title for your movie.
   - **Copyright**: Enter copyright information for your movie.
   - **Author**: Enter author information for your movie.
   - **URL**: Enter the URL from which the file is streaming.
   - **Seconds**: Enter the video length in seconds.
   - You can select a production profile. For more information on profiles, see Create a New RealMovie Profile on p.115.
5. Click **Next**. Production details appear on the page. Verify that these details are correct.
   - You can change the video file name and destination folder. To do this, click **...**, then enter a new name or locate a new folder.
   - To ensure that all of your video clips have the same interlacing format, click **Scan source video clips and set field order**.

   **Note:** This is an extremely important step to take before producing your final movie, as it can drastically affect final video quality!

6. Click **Start**. The production process begins. This process may take a few minutes.
   - To stop the production process before completion, click **Abort**.
   - To return to Edit mode after production is complete, click **Home**.

**Create a New RealMovie Profile**

To create a new custom production profile, do this:

1. Click **...**. The Profile Setup dialog box appears.

   ![Profile Setup dialog box](image)

2. Enter a new profile name.
3. Click the Settings tab and modify the Video, Audio, and Target Audience Settings, if necessary:

4. Click OK to close the dialog box.
   - To edit a custom production profile, click and edit the necessary information.
   - To delete a profile, click . A warning message appears, asking if you want to delete the profile. Click OK. The profile is deleted.
   - To view a profile’s production details, select the profile whose details you want to view, then click . The Details dialog appears, displaying the profile’s details. Click OK to close the dialog.
Create a QuickTime File for Streaming

To produce a QuickTime movie that you can stream over the Internet, do this:

1. Click to open the Production Wizard.
2. Click , then Next. Streaming file production options appear on the page.
3. Select the QuickTime movie file format.
4. Select a production profile. For more information on profiles, see Create a New QuickTime Profile on p.118.
5. Click Next. Production details appear on the page. Verify that these details are correct.
   • You can change the video file name and destination folder. To do this, click , then enter a new name or locate a new folder.
   • To ensure that all of your video clips have the same interlacing format, click Scan source video clips and set field order.

Note: This is an extremely important step to take before producing your final movie, as it can drastically affect final video quality!
6. Click **Start**. The production process begins. This process may take a few minutes.
   - To stop the production process before completion, click **Abort**.
   - To return to Edit mode after production is complete, click **Home**.

Create a New QuickTime Profile

To create a new custom production profile, do this:

1. Click **Profile Setup**. The Profile Setup dialog box appears.

2. Enter a new profile name.
3. Click the Video Compressor tab and set your Video Setting options:
4. Click the Video tab and modify the video options, if necessary:

![Profile Setup Dialog](image)

- **Compressor Component**: Select a compression scheme display size from the drop-down list.
- **Video Size**: Select a video display size from the drop-down list.
- **Video Type**: Select a video codec type from the drop-down list.
- **Video Quality**: Select a video quality from the drop-down list.
- **Key Frame Rate**: Use the arrows to set a key frame rate (between 0 and 32). For information on key frames, see key frame on p.146.

5. Click **OK** to close the dialog box.

- To edit a custom production profile, click ![Edit Profile](image) and edit the necessary information.
- To delete a profile, click ![Delete Profile](image). A warning message appears, asking if you want to delete the profile. Click **OK**. The profile is deleted.
- To view a profile’s production details, select the profile whose details you want to view, then click ![View Production Details](image). The Details dialog appears, displaying the profile’s details. Click **OK** to close the dialog.
Write Back to DV Tape

You may want to produce your movie in order to write it back to DV tape. This allows you to store your movie in a convenient, digital format that can easily be imported into another computer for further editing.

To produce a movie that you can write back to DV tape, do this:

1. Click to open the Production Wizard.
2. Click , then Next. Options for writing to disc appear on the page.
3. Click Next.
4. Click **Next**. Production details appear on the page. Verify that these details are correct.

- You can change the video file name and destination folder. To do this, click ..., then enter a new name or locate a new folder.

5. Click **Start**. The production process begins. This process may take a few minutes.
   - To stop the production process before completion, click **Abort**.
   - To return to Edit mode after production is complete, click **Home**.

6. When production is complete, the Write to DV Tape dialog box opens.
7. Locate the position at which you would like to begin writing to tape. You may do this in one of the following ways:
   - Use the playback buttons.
   - Drag the time slider.
   - Enter a timecode in the timecode box. [00:00:00:13]
8. Your produced movie file appears in a list in the window.
   - Click \( + \) to add new files to the file list. Select a file and click \( - \) to remove it from the file list.
   - Select a file then click \( \uparrow \) to bring it closer to the beginning of your movie when writing to tape. Click \( \downarrow \) to move it toward the end.
   - To ensure that all of your video clips have the same interlacing format, click Scan source video clips and set field order.

**Note:** This is an extremely important step to take before producing your final movie, as it can drastically affect final video quality!

9. Click Start. A message appears asking you to ensure your tape is at correct location and not write-protected. (Writing back to tape overwrite any content currently on the tape at that position.)

10. Click Yes. Writing begins.
   - Click Abort to stop.
   - If successful, a confirmation message appears.
11. Click OK.
Appendix

This chapter contains reference information to help answer questions you may have about the digital movie production process or about using CyberLink PowerDirector.

This chapter contains the following sections:

- Technical Support on p.124
- Hotkeys on p.126
- FAQ on p.133
- The Right Technology on p.139
- Glossary on p.144
Technical Support

Before seeking technical support, please read your user's guide or online help, and check out the Readme file for more information. You may also contact your local distributor/dealer. If your problem is still not resolved, the following sections provide ways to obtain technical support from CyberLink.

Web Support

Web support is available 24 hours a day:

support.gocyberlink.com

In addition to frequently asked questions, our website also provides troubleshooting techniques, the latest in product news, and other relevant information.

Fax Support

In order to answer your technical questions as quickly as possible, you may fax us at:

(886) 2-8667-1300

Note: Technical support is only offered to registered users, so please make sure to include your CD-key when faxing.
Telephone Support

You are welcome to call CyberLink’s Technical Support Hotline at:

(886) 2-8667-1298

**Note:** Technical support is **only offered to registered users**, so please make sure your CD-key is ready when calling.

Phone support hours are:

Monday-Friday, 9:00 a.m. - 5:00 p.m. Taiwan local time (GMT +8:00) excluding holidays.

When calling for support, please have your computer ready and provide us with the following information:

- registered CD-key
- product version
- Windows version
- hardware types (capture card, sound card, VGA card) and their specifications
- warning messages displayed
- detailed problem description and when it occurred
CyberLink PowerDirector

Hotkeys

PowerDirector allows you to employ a number of hotkeys to make working with video quicker and easier. These hotkeys are organized by function and described below.

System Hotkeys

<table>
<thead>
<tr>
<th>Hotkey</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alt + space bar</td>
<td>Open the Minimize menu in the top-left corner</td>
</tr>
<tr>
<td>Alt + F4</td>
<td>Exit PowerDirector</td>
</tr>
</tbody>
</table>

Project Hotkeys

<table>
<thead>
<tr>
<th>Hotkey</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl + N</td>
<td>Create new project</td>
</tr>
<tr>
<td>Ctrl + O</td>
<td>Open existing project</td>
</tr>
<tr>
<td>Alt + Enter</td>
<td>Display project properties</td>
</tr>
<tr>
<td>Ctrl + S</td>
<td>Save project</td>
</tr>
<tr>
<td>Ctrl + Shift + S</td>
<td>Save project as</td>
</tr>
</tbody>
</table>
## Workspace Hotkeys

<table>
<thead>
<tr>
<th>Hotkey</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tab</td>
<td>Switch between Timeline/Storyboard</td>
</tr>
<tr>
<td>Home</td>
<td>Go to the beginning of clip/project</td>
</tr>
<tr>
<td>End</td>
<td>Go to the end of clip/project</td>
</tr>
<tr>
<td>Ctrl + right arrow</td>
<td>Go to next clip in the track (Clip mode)</td>
</tr>
<tr>
<td>Ctrl + left arrow</td>
<td>Go to previous clip in the track (Clip mode)</td>
</tr>
<tr>
<td>Ctrl + C</td>
<td>Copy</td>
</tr>
<tr>
<td>Ctrl + X</td>
<td>Cut</td>
</tr>
<tr>
<td>Ctrl + V</td>
<td>Paste</td>
</tr>
<tr>
<td>+</td>
<td>Zoom ruler In</td>
</tr>
<tr>
<td>-</td>
<td>Zoom ruler out</td>
</tr>
</tbody>
</table>

## Menu Hotkeys

<table>
<thead>
<tr>
<th>Hotkey</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alt + F</td>
<td>Open File menu</td>
</tr>
<tr>
<td>Alt + E</td>
<td>Open Edit menu</td>
</tr>
<tr>
<td>Alt + V</td>
<td>Open View menu</td>
</tr>
<tr>
<td>Alt + T</td>
<td>Open Capture menu</td>
</tr>
<tr>
<td>Alt + P</td>
<td>Open Playback menu</td>
</tr>
<tr>
<td>Alt + H</td>
<td>Open Help menu</td>
</tr>
</tbody>
</table>
**Smart Guide Hotkeys**

<table>
<thead>
<tr>
<th>Hotkey</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl + Alt + T</td>
<td>Display Trim options</td>
</tr>
<tr>
<td>Ctrl + Alt + S</td>
<td>Display Speed options</td>
</tr>
<tr>
<td>Ctrl + Alt + C</td>
<td>Display Color options</td>
</tr>
<tr>
<td>F2</td>
<td>Display PiP Modification Options/Title Designer</td>
</tr>
</tbody>
</table>

**Main Panel Hotkeys**

<table>
<thead>
<tr>
<th>Hotkey</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>F1</td>
<td>Help</td>
</tr>
<tr>
<td>Ctrl + + (plus)</td>
<td>Increase volume</td>
</tr>
<tr>
<td>Ctrl + - (minus)</td>
<td>Decrease volume</td>
</tr>
<tr>
<td>Ctrl + Backspace</td>
<td>Mute/unmute</td>
</tr>
<tr>
<td>Delete</td>
<td>Delete selected item(s)</td>
</tr>
<tr>
<td>Ctrl + Z</td>
<td>Undo</td>
</tr>
<tr>
<td>Ctrl + Y</td>
<td>Redo</td>
</tr>
<tr>
<td>Shift + F12</td>
<td>Show Hotkey list help</td>
</tr>
<tr>
<td>F9</td>
<td>Switch to Capture mode</td>
</tr>
<tr>
<td>F10</td>
<td>Switch to Edit mode</td>
</tr>
<tr>
<td>F11</td>
<td>Switch to Produce mode</td>
</tr>
<tr>
<td>F12</td>
<td>Switch to Burn mode (open PowerProducer)</td>
</tr>
</tbody>
</table>
## Library Hotkeys

<table>
<thead>
<tr>
<th>Hotkey</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>F5</td>
<td>Display Media Room</td>
</tr>
<tr>
<td>F6</td>
<td>Display Effect Room</td>
</tr>
<tr>
<td>F7</td>
<td>Display Title Room</td>
</tr>
<tr>
<td>F8</td>
<td>Display Transition Room</td>
</tr>
<tr>
<td>Shift + F9</td>
<td>Display Audio Mixer</td>
</tr>
<tr>
<td>Shift + F10</td>
<td>Display Voice-over Recording Room</td>
</tr>
<tr>
<td>Ctrl + Enter</td>
<td>Display media in Media Viewer</td>
</tr>
<tr>
<td>Ctrl + A</td>
<td>Select all</td>
</tr>
<tr>
<td>Ctrl + Tab</td>
<td>Switch between filters</td>
</tr>
<tr>
<td>Ctrl + D</td>
<td>Detect scenes</td>
</tr>
<tr>
<td>Ctrl + Q</td>
<td>Load media file(s)</td>
</tr>
<tr>
<td>Ctrl + W</td>
<td>Load a media folder</td>
</tr>
</tbody>
</table>

## Capture Hotkeys

<table>
<thead>
<tr>
<th>Hotkey</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl + R</td>
<td>Record</td>
</tr>
<tr>
<td>Ctrl + /</td>
<td>Stop recording</td>
</tr>
<tr>
<td>Space bar</td>
<td>DV play/pause</td>
</tr>
<tr>
<td>Ctrl + , (comma)</td>
<td>DV rewind</td>
</tr>
<tr>
<td>Ctrl + . (period)</td>
<td>DV fast forward</td>
</tr>
<tr>
<td>Ctrl + /</td>
<td>DV stop</td>
</tr>
</tbody>
</table>
**Preview Window Hotkeys**

<table>
<thead>
<tr>
<th>Hotkey</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Space</td>
<td>Play/pause</td>
</tr>
<tr>
<td>Ctrl + /</td>
<td>Stop</td>
</tr>
<tr>
<td>, (comma)</td>
<td>Previous frame</td>
</tr>
<tr>
<td>. (period)</td>
<td>Next frame</td>
</tr>
<tr>
<td>Page Up</td>
<td>Skip 1 second backward</td>
</tr>
<tr>
<td>Page Down</td>
<td>Skip 1 second forward</td>
</tr>
<tr>
<td>F</td>
<td>Fast forward</td>
</tr>
<tr>
<td>[</td>
<td>Mark in</td>
</tr>
<tr>
<td>]</td>
<td>Mark out</td>
</tr>
<tr>
<td>S</td>
<td>Split</td>
</tr>
<tr>
<td>Ctrl + G</td>
<td>Goto timecode</td>
</tr>
<tr>
<td>Ctrl + E</td>
<td>Display Precise Cut trimmer (when enabled)</td>
</tr>
<tr>
<td>F3</td>
<td>Switch to Movie mode</td>
</tr>
<tr>
<td>F4</td>
<td>Switch to Clip mode</td>
</tr>
<tr>
<td>Ctrl + Enter</td>
<td>Display media in Media Viewer</td>
</tr>
<tr>
<td>Ctrl + U</td>
<td>Adjust system volume</td>
</tr>
</tbody>
</table>

**Settings Panel Hotkey**

<table>
<thead>
<tr>
<th>Hotkey</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl + P</td>
<td>Take a snapshot</td>
</tr>
</tbody>
</table>
### Title Designer Hotkeys

<table>
<thead>
<tr>
<th>Hotkey</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl + B</td>
<td>Set text in bold</td>
</tr>
<tr>
<td>Ctrl + I</td>
<td>Set text in italics</td>
</tr>
<tr>
<td>Ctrl + L</td>
<td>Left-align text</td>
</tr>
<tr>
<td>Ctrl + R</td>
<td>Right-align text</td>
</tr>
<tr>
<td>Ctrl + E</td>
<td>Center-align text</td>
</tr>
<tr>
<td>Ctrl + T</td>
<td>Show/hide TV Safe lines</td>
</tr>
<tr>
<td>Ctrl + G</td>
<td>Show/hide Gridlines</td>
</tr>
<tr>
<td>Ctrl + M</td>
<td>Show/hide Title mask</td>
</tr>
</tbody>
</table>

### PiP Designer Hotkeys

<table>
<thead>
<tr>
<th>Hotkey</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl + T</td>
<td>Show/hide TV Safe lines</td>
</tr>
<tr>
<td>Ctrl + G</td>
<td>Show/hide Gridlines</td>
</tr>
</tbody>
</table>

### Voice-over Hotkeys

<table>
<thead>
<tr>
<th>Hotkey</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Q or mouse wheel up</td>
<td>Increase microphone volume</td>
</tr>
<tr>
<td>A or mouse wheel down</td>
<td>Decrease microphone volume</td>
</tr>
<tr>
<td>Ctrl + H</td>
<td>Fade in</td>
</tr>
<tr>
<td>Ctrl + J</td>
<td>Fade out</td>
</tr>
<tr>
<td>Ctrl + R</td>
<td>Start recording</td>
</tr>
<tr>
<td>Ctrl + /</td>
<td>Stop recording</td>
</tr>
</tbody>
</table>
### Audio Mixer Hotkeys

<table>
<thead>
<tr>
<th>Hotkey</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>I</td>
<td>Increase Video track volume</td>
</tr>
<tr>
<td>J</td>
<td>Decrease Video track volume</td>
</tr>
<tr>
<td>O</td>
<td>Increase Voice track volume</td>
</tr>
<tr>
<td>K</td>
<td>Decrease Voice track volume</td>
</tr>
<tr>
<td>P</td>
<td>Increase Music track volume</td>
</tr>
<tr>
<td>L</td>
<td>Decrease Music track volume</td>
</tr>
</tbody>
</table>
Appendix

FAQ

Answers to the most frequently asked questions concerning CyberLink PowerDirector are listed below. If you require further information, see Technical Support on p.124.

1. **What's new in PowerDirector 3?**

   New video file format support:
   - Windows Media Video 9 (WMV) input support
   - QuickTime 6 input & output support
   - DivX 5 codec included to input & output MPEG4 video

   New interface:
   - Timeline/Storyboard dual-mode editing
   - 6 editing tracks: Video, Effect, PiP, Title, Voice, Music
   - Dynamic scaling timeline ruler
   - Dynamic interface resolution that supports all screen resolutions larger than 1024x768
   - Hotkey hints displayed in tool tips

   New capturing features
   - Automatically detect available devices and list on control panel easy selection
   - Preview video files immediately after capture
   - Review and delete unwanted captured video files before importing them into the Library
   - Information panel that provides detail capturing information for better disk space control.
   - DV QuickScan feature that allows users to preview an entire DV tape in 6 minutes. When users select desired video intervals, the program rewinds to the marked intervals and performs high quality capturing.

   Improved Library management tools:
   - Aliasing for video, audio, and image files for easier use in the workspace
New editing features

- Exclusive fast forward preview allows fast previewing (2x-16x speed) to locate desired video segments
- Double-Precision trimming bar that allows quick and precise trimming for editing longer videos
- Large screen Media Viewer and Media Editor allow better visibility when previewing or editing video
- New speed tool changes video playback speed without changing audio pitch. Great for video files containing background music
- New speed tool automatically calculates the exact speed required to fit an specific time
- Favorites category for storing video, title, and transition effects in the Library
- New Replace Color effect changes the color of a single object (e.g.: color of the sky) in a video or image clip
- New Title Designer adds shadows and gradient colors on text face and shadow
- New Title Mask allows partial title animations
- New PiP Designer adds PiP borders/shadows/motion
- 3-track, real-time Audio Mixer adjusts track volume in real-time during video playback
- Voice-over recorder records real-time narrative voice-overs during video playback. The recorded voice is automatically synchronized with the video portion

New production features

- Enhanced rendering engine utilizes the new MPEG encoder/decoder to improve video quality and encoding performance
- Optimized with AMD 3DNow, Intel MMX, SSE, SSE2, and the newest HyperThreading technology
- Auto-detection of TV format: automatically detects whether video is interlaced or progressive to ensure best quality
- New Smart Video Rendering Technology 2 (SVRT2) improves the patented SVRT further by separating rendering between video and audio.
2. **What is the difference between CyberLink PowerProducer and CyberLink PowerDirector?**

CyberLink PowerProducer is mainly for users who want to burn the home videos they have saved on their computer, camcorder, or digital camera to DVD/CD so they can share them with friends and family. PowerProducer users generally want a quick solution without learning how to edit video.

CyberLink PowerDirector, on the other hand, allows users to explore their creativity in the field of digital video editing. PowerDirector boasts powerful video editing tools, numerous effects, and audio tracks for a more complete movie creation experience. Like PowerProducer, PowerDirector also exports videos to DVD/CD.

3. **How do I know if my DVD player will play the DVDs I create with PowerDirector?**

Movie titles/discs created by PowerDirector have been thoroughly tested in the Class A verification lab approved by the DVD Forum. This means we are being verified and tested in world class labs that guarantee our compatibility. A DVD player that carries a DVD-video compatible logo should playback any movie discs without any problems.

4. **What file formats can be imported by PowerDirector?**

- **Video**: .avi, .dat, .mpe, .mpg, .mpeg, DivX (requires codec), .wmv
- **Audio**: .mp3, .wav, .wma
- **Photo**: .bmp, .gif, .jpe, .jpeg, .jpg, .tif, .tiff

5. **What movie disc types can be produced by PowerDirector?**

- DVD
- DVD folders and disc images
- MiniDVD (DVD-Video on CD)
- SVCD/VCD
6. **What is SVRT/SVRT II and when can I use it?**

SVRT (Smart Video Rendering Technology) is a proprietary rendering technology from CyberLink that intelligently recognizes which portions of a movie clip have been modified, and only renders those portions - not the entire video clip - during production. Rendering only the modified portions of a video clip saves time and preserves the original quality of the video. Using SVRT, PowerDirector renders MPEG-1, MPEG-2, and DV-AVI video faster than any other software on the market. (Other video editing software programs have to render the entire video even if one single frame has been modified!)

SVRT II further breaks movie clips into their component video and audio parts, then renders only the audio or video portion that has been modified. This further reduces the amount of time needed for production!

CyberLink’s Smart Video Rendering Technology is available during production when the frame rate, frame size, and file format of video files in your movie are the same (and bitrate is similar). In this case, SVRT is used to render these files. If any clips do not meet the above criteria, they are fully rendered without SVRT.

If you have previously produced a disc using SVRT and the disc encountered compatibility issues with your player, render the video again without using SVRT. (Some players are unable to play back MPEG video with a modified GOP pattern.)
7. What is “editable DVD”?

Editable DVD is to make your authored DVD able to be further edited even when it's already burn on a disc. By applying this technology, you will be able to record your DVD quickly and you will also be able to append new videos, change backgrounds later when you finished it. Editable DVD is 100% compatible with your DVD player.

8. How do I know if my hardware is compatible with or supported by PowerDirector?

Check out the hardware approval sheet in the readme file. An updated version can also be found on CyberLink's website.

9. Which languages does PowerDirector support?

PowerDirector supports the languages listed below:
- Chinese, Simplified
- Chinese, Traditional
- English
- French
- German
- Italian
- Japanese
- Korean
- Spanish

10. Commercial DVDs often contain up to 3 hours of video. How can I use PowerDirector to make a DVD that long?

Change the video quality setting in the Select Your Disc page of PowerProducer. When you select a video quality, the detailed attributes of that quality setting are displayed at the bottom of the PowerDirector interface. For more information, see Video Quality on p.142.
11. Isn't MPEG encoding slow? How does PowerDirector increase production speed?

Using SVRT, PowerDirector only renders the modified part of a video sequence, without rendering the untouched parts. This speeds up production time considerably. SVRT is the smartest way to render MPEG and still retain the original video quality.
The Right Technology

With a seemingly unending array of technologies in the digital video industry, selecting exactly which is suitable for your movie may seem overwhelming. Should you burn your movie to CD or DVD? Should you use HQ, SP, or LP video quality? What are NTSC and PAL? This section takes the guesswork out of digital technology, so you can turn a daunting choice into creative freedom.

CD vs. DVD

In broad terms, discs are divided into CD (which, being the earlier technology, is more widely supported) and DVD (which holds much more content). CDs and DVDs look the same and do pretty much the same thing: store data. Both can be used to record your movie, so how do you decide which to use?

The most important factor is compatibility, which can be decided by answering the following two questions:

- What disc type is supported by my disc burner?
- What disc type is supported by my disc player?

The answer to these questions may decide the disc type you use, but if you are still faced with several choices, consider that DVDs hold 7 times the amount of video than CDs, and can contain menus pages. CDs, on the other hand, are cheaper, and may be sufficient if you plan to make numerous copies of a short video.

Disc Type Overview

Below is a comparison chart of the major disc types:

- **VCD**  74/80 mins of video; VHS quality
- **SVCD** 35 mins of video; quality close to DVD
- **DVD**  60-90+ mins video; highest quality
Following is an in-depth look at all of the available CD/DVD types.

CD Types

CD denotes a disc size that contains up to 74/80 minutes of high quality video or 650/700 MB of data. DVDs, VCDs, SVCDs, and miniDVDs (despite the name) are all CD size. CDs can be played on standalone players and most computers.

CD-R
CD-R is a once-writable format. CD-RW writers and some new DVD writers can write in CD-R, and most DVD players can also read this format. The CD-R format is commonly used for distribution of computer data and digital audio.

CD-RW
CD-RW is a rewritable CD format. CD-RW writers and some new DVD writers can write in CD-RW, and most DVD players can also read this format. The CD-RW format is best suited for storage of computer data and digital audio.

SVCD
SVCD (Super Video Compact Disc) is a CD-size disc that offers much higher video quality than VCD, but lower than that of DVD. It can hold 35 minutes of video, and can contain menus and chapters like a DVD, as well as slideshows with background audio. SVCD can be played on a PC with DVD playback software, and on some standalone DVD players.

VCD
VCD (Video Compact Disc) is a CD format that contains audio and video of a quality about the same as that of VHS, and menus and chapters like a DVD. VCD uses the MPEG compression standard, and can be played on a PC with VCD/MPEG playback software and on most stand-alone DVD players.
DVD Types

DVD is a high capacity CD-size disc that holds anywhere from 1-12 gigabytes of data, or from 1-6+ hours of video (depending on the type of DVD). Using the High Quality setting, you can expect to be able to record 1-2 hours of video.) DVDs can be played on standalone players and computers equipped with DVD drives.

**DVD-R**

DVD-R is a once-writable DVD format. It is a competitor product to DVD+R, and is therefore not compatible with that format. Some new DVD writers can write in both DVD-R and DVD+R, and most DVD players can read both formats.

**DVD-RW**

DVD-RW is a DVD format that can be written to about 1,000 times. It is a competitor product to DVD+RW, and is therefore not compatible with that format. Some new DVD writers can write in both DVD-RW and DVD+RW, and most DVD players can read both formats.

**DVD+R**

DVD+R is a once-writable DVD format. It is a competitor product to DVD-R, and is therefore not compatible with that format. Some new DVD writers can write in both DVD-R and DVD+R, and most DVD players can read both formats.

**DVD+RW**

DVD+RW is a rewritable DVD format that can be written to about 1,000 times. It is a competitor product to DVD-RW, and is therefore not compatible with that format. Some new DVD writers can write in both DVD-RW and DVD+RW, and most DVD players can read both formats.

**MiniDVD**

MiniDVD is a variation of DVD, in which true DVD media (including menus and high-resolution video) is placed on a disc in CD-R/W format. While technically a DVD in terms of data structure, miniDVD is not supported by many DVD players because the format is mistaken for standard CD media.

**Note:** For more information on the DVD-R/RW formats, see [www.dvdrhelp.com/dvd](http://www.dvdrhelp.com/dvd). For more information on the DVD+R/RW formats, see [www.dvdrw.com](http://www.dvdrw.com). For more information on DVD in general, check out the very informative FAQ on [http://dvddemystified.com](http://dvddemystified.com).
NTSC vs. PAL

NTSC and PAL are formats adopted by television broadcasters in different countries. The main difference between the two formats is the number of frames per second they offer: 30 in NTSC, and 25 in PAL. This difference means that a movie recorded in NTSC format is unplayable by a PAL player and vice versa.

Fortunately, the question of whether to use PAL or NTSC television format for your disc can be reduced to the following simple question:

- In which country do you plan to play this disc?

Since all countries use either the NTSC or PAL format, knowing the country in which the disc will be played pretty much resolves this issue for you. By selecting the desired country in PowerDirector, the television format (PAL or NTSC) is automatically set.

Note: Generally speaking, the United States, Japan, Canada, and Mexico use NTSC, while Germany, Great Britain, South America, Australia, and most Western European and Asian countries use PAL.

Video Quality

The different video quality settings (HQ, SP, and LP) available in CyberLink PowerDirector result in a final picture of higher or lower quality and a movie file of larger or smaller size. Better quality video also demands more from your computer and limits the video duration you can burn to disc. Below is a comparison of the length of video you can expect to be able to burn to a DVD using the different qualities:

- HQ (High Quality): 60 mins
- SP (Standard Play): 120 mins
- LP (Long Play): 180 mins

For the best possible image in your final production, select the highest video quality that will allow your production to fit onto the disc type you are using. Your ultimate choice of video quality,
however, should be based both on the image quality you want in your final production and on the processing power of your computer.
Glossary

The glossary provides definitions of terms used in this user’s guide that you may find unfamiliar.

**CD-R**
A once-writable CD format that can hold up to 74 or 80 minutes (650 or 700 MB) of data. CD-RW writers and some new DVD writers can write in CD-R, and most DVD players can also read this format. The CD-R format is commonly used for distribution of computer data and digital audio.

**CD-RW**
A rewritable CD format that can hold up to 74 or 80 minutes (650 or 700 MB) of data. While CD-RW discs can be reused, they are not supported by all CD drives. CD-RW writers and some new DVD writers can write in CD-RW, and most DVD players can also read this format. The CD-RW format is best suited for storage of computer data and digital audio. CD-RWs can be written to about 1,000 times.

**chapter**
A marker set in a video clip in order allow viewers to jump to that specific point for navigation purposes.

**clip**
A video, audio, or image file that has been loaded into PowerDirector’s Library for use in your movie.

**color filter**
An option in PiP effects that makes a selected color transparent, allowing the underlying clip to show through in the transparent areas.

**contrast**
The relative difference between the highlights and shadows in a picture.

**deinterlacing**
Methods used to reduce or eliminate the decrease in video quality caused by interlacing.

**DV**
(Digital Video) Refers to the capturing, manipulation and storage of video in digital formats. The DV format is an international standard for consumer use created in 1995 by a consortium of companies.

**DVD**
(Digital Versatile Disc) A high capacity CD-size disc for video, multimedia, games and audio applications.
**DVD folder**  
A folder containing all of the media files for your production that can be burned to a disc for storage.

**DVD-R**  
A DVD format that allows you to write once. It is a competitor product to DVD+R, and is therefore not compatible with that format. Some new DVD writers can write in both DVD-R and DV+R, and most DVD players can read both formats. For more detailed information, see www.dvdrhelp.com/dvd or other web sources.

**DVD+R**  
A DVD format that allows you to write once. It is a competitor product to DVD-R, and is therefore not compatible with that format. Some new DVD writers can write in both DVD+R and DVD-R, and most DVD players can read both formats. For more detailed information, see www.dvdrw.com or other web sources.

**DVD-ROM**  
A read-only DVD format commonly used for distribution of movies (which are more specifically referred to as DVD-Video) and computer games.

**DVD-RW**  
A DVD format that can be written to about 1,000 times. It is a competitor product to DVD+RW, and is therefore not compatible with that format. Some new DVD writers can write in both DVD-RW and DVD+RW, and most DVD players can read both formats. For more detailed information, see www.dvdrhelp.com/dvd or other web sources.

**DVD+RW**  
A rewritable DVD format that can be written to about 1,000 times. It is a competitor product to DVD-RW, and is therefore not compatible with that format. Some new DVD writers can write in both DVD+RW and DVD-RW, and most DVD players can read both formats. For more detailed information, see www.dvdrw.com or other web sources.

**file**  
A video, audio, or image file that resides on your hard drive, a disc, or other storage medium.
**GOP pattern** (Group of Pictures pattern) A pattern in MPEG encoding made up of groups of pictures (consisting of I-, B-, and P-frames), which have certain dependent relationships during encoding. Changes to this pattern can cause playback errors in some players.

**hold time** Used to describe the time a moving effect (PiP or title effect) remains stationary on the screen.

**HQ** (High Quality) The highest video quality you may select in PowerDirector.

**hue** The attribute of a color that distinguishes it from other colors.

**interlacing** Flickering or artefacts caused by the way video signals are broadcast. (Each frame of video is made up of a number of lines. When video frames are broadcast, the odd lines of the screen display are illuminated first, then the even lines. This causes the interlacing problem, which is most evident when the video contains motion.)

**key frame** A key frame is defined as a frame in a video sequence that does not require information from a previous frame for decompression. More key frames yield better video quality but require greater amounts of disk space.

**LP** (Long Play) The lowest video quality you may select in PowerDirector.

**menu** A page on a DVD that contains links to the chapters the DVD contains.

**MiniDVD** A variation of DVD, in which a true DVD (including menus and high-resolution video) is placed on a disc in CD-R/W format. While technically a DVD in terms of data structure, MiniDVD is not supported by most DVD players because the format is mistakenly recognized as standard CD media. MiniDVD is playable on a PC with DVD playback software, but on very few stand-alone DVD players.
MPEG (Moving Picture Experts Group) A family of international standards used for coding audio/video information into digital format. Currently, MPEG-2 is the standard for digital video formats and MP3 for strictly digital audio formats.

non-realtime capture Non-realtime capture continues processing video after the video capture playback stops in order to ensure that no frames are dropped. Capturing video at a higher speed reduces processing time, but yields video of a lower quality. Capturing better quality video requires more CPU power and more time to complete.

NTSC (National Television Systems Committee) A standard format adopted by the FCC for television broadcasts in the United States, Japan, Canada, and Mexico. NTSC offers 525 lines of resolution per frame at 30 fps.

PAL (Phase Alteration Line) The standard format for television broadcasts in Germany, Great Britain, South America, Australia, and most of Western European and Asian countries. PAL offers 25 frames per second.

realtime capture Realtime capture completes capturing during playback of the original video. Realtime capture requires high processing speeds and risks dropped frames.

render To compile a video production from its component video, audio, photo, and settings parts.

saturation The richness of a color.

slide An individual photo within a slideshow. Slides are contained within albums.

slideshow A presentation that can include both photos (called slides) and effects, such as transitions and background music. The photos and effects in a slideshow are contained in units called albums, which can contain any number of photos, as well as transitions and music.
SP (Standard Play) The median video quality in PowerDirector, inferior to HQ but superior to LP.

streaming Streaming is a data transfer technology that allows viewers to play a file received over the Internet without downloading it onto their own computer.

SVCD (Super Video Compact Disc) A CD-size disc format that offers much higher video quality than VCD, but lower than that of DVD. It can hold 35 minutes of video, and can contain menus and chapters like a DVD, as well as slideshows with background audio. SVCD can be played on a PC with DVD playback software, and on some standalone DVD players.

SVRT, SVRT II (Smart Video Rendering Technology) A proprietary movie rendering technology from CyberLink that only compiles those portions of a movie clip that have been modified, reducing the amount of time needed for production. SVRT II is able to discern between audio and video portions of a movie clip, and only renders the portion that has been modified. For a fuller discussion of SVRT/SVRT II, see What is SVRT/SVRT II and when can I use it? on p.136.

Type I Method of storing DV data in AVI format that was defined by Microsoft. This format stores data (i.e. video and audio) as a single AVI stream. It offers better compression, but is newer, and therefore compatible with fewer systems than Type II.

Type II Method of storing DV data in AVI format that was defined by Microsoft. This format stores data (i.e. video and audio) as a single video stream and 1-4 audio streams to store DV data. It offers wider compatibility, but uses an older compression than Type I. This format requires slightly more processing time to split the video/audio stream while capturing.
| **VCD** | (Video Compact Disc) A CD that contains audio and video of a quality about the same as that of VHS. VCD can hold up to 74/80 minutes of video on a 650/700Mb disc, and can contain menus and chapters like a DVD, as well as slideshows with background audio. VCD uses the MPEG compression standard, and can be played on a PC with VCD/MPEG playback software and on most stand-alone DVD players. |
| **volume key** | A point you can set within an audio track in order to increase or decrease volume beginning at that point. |
| **WMV** | (Windows Media Audio) A Windows streaming audio format used for files destined to be downloaded or played over the Internet. |
CyberLink PowerDirector
Index

A
adding
  clips to workspace 52
aliases 49
analog video capture options 30
audio
  adding clips to the workspace 54
  capture options 31
  compression bitrate 100
Audio Mixer
  adding fade effect in 65
  mixing audio in 65
  visual overview 16
AVI
  producing files 101
  production profiles 106

B
batch capturing 37
border in PiP effects 80
Burn mode, visual overview 24
burning
  producing a movie for 97

C
capture
  batch 37
  from CD 43
  from DV device 35
  from microphone 42
  from PC camera 41
  from TV 40
  from webcam 41
  limit options 28
  media 25
  mode, visual overview 12
  preferences 26
  single scene 35
capture options 28
  analog video options 30
audio 31
CD 33
deleting captured files 34
detecting scenes 34
fade-ins in 31
fade-outs in 31
limits 28
microphone 33
naming captured files 34
TV 30
webcam 32
captured clip options 34
CD
  capture profile setup 33
  capturing from 43
  types 140
  vs. DVD 139
CD-R
  definition 144
  description 140
CD-RW
  definition 144
  description 140
chapters
  definition 144
clips
  definition 144
  previewing in Media Editor 68
  previewing in preview window 67
  trimming 57
color boards, adding to the workspace 53
color filter
  adding to PiP effects 84
  definition 144
contrast, definition 144
copying
  clips in workspace 55
  effects in workspace 74
countries that use NTCS/PAL 142
creating
  MPEG production profile 99
customizing
  MPEG production profile 99
cutting
  clips in workspace 55
  effects in workspace 74

D
default durations, setting 5
deinterlacing 100
definition 144
deleting
captured file 34
effects from Timeline 73
files from disk 48
detecting scenes
by changing timecodes 50
in captured clips 34
in video clips 50
setting sensitivity 50
disc types
CD 140
DVD 141
supported 135
DivX files, producing 108
dragging
clips in the workspace 54
effects in the workspace 74
to trim clips 58
to trim effects 77
durations
of effects 76
DV
definition 144
parameters 27
tape, writing to 120
DV AVI
detecting scenes in 50
DV camcorder, capturing from 35
DVD
definition 144
types 141
vs. CD 139
DVD folder
definition 145
DVD+R
definition 145
description 141
DVD+RW
definition 145
description 141
DVD-R
definition 145
description 141
DVD-ROM
definition 145
description 141
DVD-RW
definition 145
description 141

E
Edit mode 13

editable DVD, what is 137
editing
preferences 26
Effect Room 15
effects
adding to Favorites 71
moving in the Timeline 74
previewing in Media Editor 92
previewing in preview window 91
removing from Favorites 71
setting duration 76
eyedropper tool 85

F
fade-in
adding to audio clips 65
in audio capture 31
fade-out
adding to audio clips 65
in audio capture 31
FAQ 133
Favorites
adding effects to 71
removing effects from 71
fax number for technical support 124
file
definition 145
formats supported 135
font in title effects, modifying 87

G
general preferences 5
generating
AVI files 101
DivX files 108
MPEG files 110
RealVideo files 114
WMV files 112
glossary 144
GOP pattern 146

H
high quality 100
definition 146
high speed 100
hold time
definition 146
setting for effects 75
hotkeys 126
hours of technical support 125
HQ quality 142
definition 146

I
image clips, adding to workspace 52
interlacing
definition 146
format, setting 63
intervals, scanning for 38
in-track audio mixing 64
introduction 1

K
key frame 146

L
languages supported 137
Library
aliases in 49
deleting files from disk in 48
detecting scenes in 50
loading media into 46
removing clips from 48
restricting display in 47
restricting display of effects in 70
sorting clips in 47
sorting effects in 70
visual overview 14
loading media 46
long play quality 142
definition 146
LP quality 142
definition 146

M
masking title effects 89
master audio level, setting 42
Media Editor
previewing effects in 92
trimming video in 59
visual overview 22
Media Room 15
media tracks, visual overview 18
Media Viewer
previewing in 68
previewing movie in 95
visual overview 21
microphone
capture profile setup 33
capturing from 42
MiniDVD
definition 146
description 141
mixing
in Audio Mixer 65
in-track 64
modes in PowerDirector 11
modifying effects
PiP 79
title 87
video 78
motion of PiP effects, modifying 83
movie
previewing in Media Viewer 95
previewing in preview window 94
movie-making process 3
moving
clips in workspace 54
effects in the Timeline 74
MPEG
definition 147
producing files 110
production profiles 99
muting
audio portion of video clips 61
audio tracks 66

N
naming captured files 34
narration, recording 44
new in PowerDirector 3 133
noise removal 100
non-realtime capture, definition 147
NTSC
definition 147
vs. PAL 142

O
OEM versions 8

P
PAL
definition 147
vs. NTSC 142
pasting
  clips in workspace 55
  effects in workspace 74
PC camera, capturing from 41
PiP effects
  adding color filter 84
  adding to workspace 70
  deleting from Timeline 73
  modifying border 80
  modifying motion 83
  modifying position 86
  modifying size 86
  modifying speed 79
  modifying transparency 86
  shadows 81
  splitting 76
position of PiP effects, modifying 86
PowerDirector
  interface 10
  modes 11
  new features 133
  versions 8
Precise Cut in trimming 59
preferences
  capture/edit 26
  general 5
pre-production
  ready to burn 10
preview window
  previewing clips in 67
  previewing effects in 91
  previewing movie in 94
  visual overview 20
previewing
  clips in preview window 67
  effects in Media Editor 92
  effects in preview window 91
  in Media Viewer 68
  movie in Media Viewer 95
  movie in preview window 94
producing
  AVI files 101
  before 93
  DivX files 108
  MPEG files 110
  QuickTime files 117
  RealVideo files 114
  WMV files 112
  your movie 93
production
  mode in visual overview 23
  profiles, AVI 106
Wizard 96
profiles
  AVI 106
  QuickTime 118
program interface 10
project files 4
quality vs speed of video 100
Quick Scan 38
QuickTime
  file production 117
  profiles 118
realtime capture, definition 147
RealVideo file production 114
recording a voice-over 44
removing
  clips from Library 48
  clips from workspace 55
renaming clips 49
render, definition 147
replacing effects in Timeline 73
restoring volume levels in audio tracks 66
restricting
  display of clips in Library 47
  display of effects in Library 70
ripping CD tracks 43
ruler, resizing 19
saturation, definition 147
scanning for intervals 38
scene detection 50
setting
  default durations 5
  master audio level 42
  undo levels 5
shadows
  in PiP effects 81
  in title effects 90
size
  limit for captures 28
  of PiP effects, modifying 86
slides
  definition 147
slideshow 147
slow-motion, adding to video 60
Smart Video Rendering Technology 136
smoothing 100
snapshot
  default destination 27
  default filename 27
  of video clip 60
sorting
  clips in the Library 47
  effects in Library 70
SP quality 142
  definition 148
speed
  of PiP effects 79
  of video clips 60
  vs. quality of video 100
splitting
  clips 56
  effects 76
standard play quality 142
  definition 148
Storyboard view, switching to 19
streaming
  definition 148
  file production, QuickTime 117
  file production, RealVideo format 114
  file production, WMV format 112
  profile, QuickTime 118
stretching audio 61
SVCD
  definition 148
  description 140
SVRT
  definition 148
  SVRT II, what is 136
  using in disc production 102
  what is 136
  when available 136
system requirements 7

T

tape, writing to 120
technical support
  telephone number 125
time limit for captures 28
Timeline view, switching to 18
title effects
  adding to Timeline 72
  deleting from Timeline 73
masking 89
modifying font 87
replacing in Timeline 73
shadows 90
splitting 76
Title Room 15
transition effects
  adding to Timeline 72
  deleting from Timeline 73
  replacing in Timeline 73
Transition Room 15
transparency of PiP effects, modifying 86
trimming
  audio & video clips 57
  dragging an edge 58
  Precise Cut 59
  video or audio 57
TV
  capture options 30
  capturing from 40
Type I AVI format, definition 148
Type II AVI format, definition 148

U

UI, default 10
Undo levels, setting 5

V

VCD
  definition 149
  description 140
versions of PowerDirector 8
video clips
  adding to workspace 52
  detecting scenes in 50
  snapshot of 60
video compression rate 99
video effects
  adding to Timeline 72
  deleting from Timeline 73
  modifying 78
  replacing in Timeline 73
  splitting 76
video overlay 26
video quality
  hint on selecting 142
  HQ 142
  LP 142
  SP 142
  video size 99, 119
visual overview 9
Audio Mixer 16
Burn mode 24
Capture mode 12
Edit mode 13
Effect Room 15
Library 14
Media Editor 22
Media Room 15
media tracks 18
Media Viewer 21
preview window 20
Production mode 23
program interface 10
Storyboard view 19
Timeline view 18
Title Room 15
Transition Room 15
Voice-over Recording Room 17
workspace 18
voice-over recording 44
Room 17
volume
changing in Audio Mixer 65
changing in-track 64
volume keys
adding to an audio track 64
definition 149

W
webcam

capturing from 41
video capture options 32
website for technical support 124
what’s new in PowerDirector 3 133
where to begin reading 2
WMV

definition 149
file production 112
workspace

adding clips to 52
visual overview 18
write to DV tape 120